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Introduction
What is ConvertPS?

ConvertPS is a product family, designed to meet all
requirements in PostScript interpretation and con-
sists of the four components:

- ConvertPS Classic,
- ConvertPS Batch,
- ConvertPS Butler, and
- ConvertPS Command Line.

With the help of ConvertPS, PostScript files may be
interpreted into more common Windows formats
such as Windows metafiles or bitmaps and may be
edited subsequently.
On the whole PostScript files may be created with
any Clipart-, CAD- or drawing program. It makes no
difference whether they were created on a personal
computer, a Macintosh-, UNIX- or any other system.
A PostScript page description can also be ‘hand
written’ in the PostScript code, called „native Post-
Script“.
To sum up PostScript files may be divided into the
following categories:

- Native PostScript code (PS)
- Encapsulated PostScript (EPS, EPSF, EPSI)
- Adobe Illustrator Format (AI)
- Printfiles (PRN), which are generated for the

output on PostScript printers

Usually these kinds of formats cannot be imported
in any other application for further editing.
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This is where ConvertPS comes into play:
ConvertPS converts the original PostScript code of
the file in question into a Placeable Metafile, or
another adequate vector format. The converted
image can subsequently be edited by any application
which can import Windows metafiles.
Furthermore ConvertPS supports QuickView for files
of the formats .PS-, .EPS- and .AI. Forthwith the
contents of all these files may be viewed directly from
out of the Explorer.
In the ConvertPS family ConvertPS Classic repre-
sents the basic program.
ConvertPS Classic is an independent product with
all neccessary functions for interpreting single files.
Converting large amounts of PostScript data is easily
achieved with the help of ConvertPS Batch.
ConvertPS Batch converts the data in the batch mode
automatically and interactive.
ConvertPS Butler is a supplementary module, which
none the less enhances the product family with a
couple of very interesting features.
These are, e.g. its function as OLE server and as
importfilter for Microsoft Office as well as Adobe
PageMaker.
With ConvertPS Command Line it is now possible
to convert files in command prompt mode of
Windows.
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Characteristics and areas of employment

The following section gives a structured outline of all
essential characteristics ConvertPS has to offer:

Input formats:

- Native or Generic PostScript (.PS)
- Encapsulated PostScript (.EPS or .EPSF).

The files may also include a preview section
in the TIFF-, WMF-, or BMP format.

- Adobe Illustrator Format (.AI)
- ConvertPS also recognizes printer specific

operators, so that most of the PostScript print
files can be processed.

Output formats:

- Windows Metafile (WMF) or
- Placeable Windows Metafile (Aldus Placeable

Metafile)
- Bitmap formats: BMP, GIF, PCX, and TIF
- Enhanced Metafile Format  (EMF)
- Vector formats : DXF, SVG and PDF

Functionality

- Support of Adobe-Type 1 and Type 3 fonts in
PostScript files or fonts installed externally on
hard disc

- Support of TrueType fonts for use as PostScript
substitute fonts

- Flexible font substitution by definition of alias
names
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- Predefined page formats (DIN A1 to DIN A5) and
free to define page formats (any size)

- Echo mode, to enable the checking of PS files
- Automatical ascertainment of bounding box to

the size of the converted image or adaptation of
page format as bounding box.

- Transformation of text in the respective graphic
format or in the according direct text output
commands

- Flexible transformation of halftone images into a
specific output format with support of internal
bitmap structures of the output formats

- Full color support
(RGB, HSB and CMYK in 24 Bit)

- Options to save the metafiles created by
converting (.WMF), or copy them into the
clipboard (= opportunity to edit files subsequently
in other applications)

- Print output on all printers supported by
Windows 95 or Windows NT

- Scaling of converted files to the respectively set
print format (e.g. converting A3 with subsequent
print output in A4 possible)

- Preview function with zoom option for converted
images und existing WMF files

- Applicability as importfilter for all Office 97-
compatible software products compatible with
Office 97, capable of importing images
(e.g.: Microsoft Word, PowerPoint or Excel)

- To sum up: ConvertPS offers the opportunity
to view and control every PostScript file on
screen, furthermore import the converted files
into most Windows applications and allow
subsequent editing and printouts.
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As all the important characteristics may be configured
to ones  needs, ConvertPS can be set to meet even
individual requirements.
ConvertPS is suitable for the professional employ-
ment in documentation- and translation departments,
as well as in the preprinting step stage of e.g. graphic-
and exposure studios or publishers. Here, the
interpreter can lead the way in preparing PostScript
files for further processing, even enabling a file
exchange between different operating systems such
as Windows, Mac-OS and UNIX.
ConvertPS offers the none professional user the
opportunity to put out PostScript files on various dif-
ferent systems, like e.g. on screen or on simple
printers which need not be equipped with the usual
PostScript implementations. This is especially useful
when PostScript files contain obscure information
or the original source files are not available any
longer.

Innovations in the version 4.5

In its upgraded version 4.5 ConvertPS has advanced
to a complete conversion system which can process
a wide scope of input and output formats.
The most innovative new features in the version 4.5
are the support of the output formats DXF, SVG and
PDF.
In addition it is now possible to convert in command
prompt mode of Windows. On the whole the user
will find more possibilities to convert PostScript files
and complete file packages.
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System requirements

The minimal requirements for optimum converting
results on your system are:

- 486 system
- 16 Mbyte RAM
- 4 Mbyte available space on hard disk
- Windows 95 or Windows NT



Installation Instructions

We advise you urgently to follow the instructions on
the installation and de-installation.
ConvertPS can be delivered on CD-ROM and on a
set of discs.

Installation by CD-ROM or discs
The installation of ConvertPS can be achieved both
by disc and by CD-ROM. The process itself is the
same with both methods.
There is merely a difference in how to open the
installation executable file (installer.exe with CD
ROM or Setup.exe with discs)
Windows offers various possibitilties for doing this.
At first  place your disc or CD-ROM in the according
drive.

CD-ROM with autorun
If Your system is set to "autorun" when installing
from CD-ROM, the Master Setup window will
appear automatically. You can now start the
installation immediately without opening the file
"installer.exe" beforehand.

CD-ROM without autorun
Is the option "autorun" not available or not activated,
or you are installing from disc, you can search for
the executable file (Setup.exe, installer.exe) via the
Microsoft Explorer or the run dialog in the Startup-
bar. When you install by CD-ROM, open the
directory of the CD-drive and simply click the file
“installer.exe“.
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Installation by disc

When you install per disc, select the corresponding
disc-drive on your system. You will find 3 folders
named disc 1, disc 2 and disc 3.
The required "Setup.exe" is to be found in the fol-
der called disc 1.

After that the ConvertPS Master Setup-window will
appear

By choosing the particular flag you can either install
the German or the English version. Additionally you
are provided with the option to install the current
version of the Acrobat Reader in order to read the
user’s guide available as a PDF document. Moreover
there is a ConvertPS product presentation in Power-
point  offered



To continue with the installation, click the "Install
ConvertPS" -button.

You can also directly select the folder with the desired
language from the same directory. Each containes
the folder

- ConvertPS_45
(containing the program installation files),

- Present
(containing the presentation in Powerpoint)

- ar302.exe
(the executable file for Acrobat Reader)

- the file proinfo.pdf
(product-information in the PDF-format).

Click the folder ConvertPS_45.

Inside you will find the same folders as on the discs
1, 2 and 3.
To start the installation of ConvertPS 4.5 call up the
file "Setup.exe" in the folder named disc 1.

The following installation procedure is generally
always the same and is not influenced by the previous
operations.
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General installation procedure

InstallShield Assistent

The installation procedure in general starts with
the Setup of the InstallShield Wizard, which
will lead you through the remaining installation
procedure.

Welcome screen

After the Install-Shield Wizard has been set up the
welcome screen appears automatically. Should you
not be familiar with this dialog as yet read the
information.
To carry on with the installation click "Next", to abort
it click "Cancel".

User information

The next dialog to appear is the "user information"
dialog: please enter the name and company na-
me on which the program is supposed to be
registered and along with that please enter the
serial number too.
We would like to point out that many errors occur
when entering the serial number due to mistaking
various letters and numbers, such as  "I" (capital
letter "i"), "1" and  "l" (small letter "L"). This can
lead to entering a wrong serial number.
Following the entry of the required information, click
"Next".



Confirmation of registration

Now you are required to confirm the registration.
The details issued are once more presented and
you are asked to check and confirm them. If the
details are correct, click "Yes". Should you want to
alter any of the details though, click "No" and the
previous dialog appears once more.

Target path

The dialog following the confirmation of the
registration details is called "target path". Select
that particular directory in which the programm files
of ConvertPS 4.5 are supposed to be saved.
Once you have appointed the optative target
directory, click "Next".

Question

In the next window you can register ConvertPS as
being the standard application for files of the type

- PostScript (PS)
- Encapsulated PostScript (EPS)
- Adobe Illustrator (AI).

This means that ConvertPS is automatically called
up to open files of these particular formats.
This option is activated by clicking the "Yes" button.
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Choose components

The next dialog field issued is called "choose
components". Here you may choose a selection
of the various components offered by ConvertPS
4.0. Choose the desired components by clicking
on them. They will then be marked by small hooks.
If the selection completed, click "Next" once again.

Select program group

The following dialog "select program group" offers
the option of listing the program ConvertPS under
a chosen key word in the start bar. "ConvertPS" is
the key word offered here, but you can choose any
word you like and enter that or select any of the
already existing programs from the list

Setup

When the necessary settings for the various
components have been completed the setup will
be initiated. A graphic depicting a progressbar
shows the progress of the installation on screen.
During the installation of the program files this
process is intervened at a certain point by another
window.



Standard PostScript directory

Select  the directory in which to save all PostScript-
files on your system  by means of the offered up
search mask.

Question

In the consecutive window you will be asked if you
want to register ConvertPS as standard application
for files of the type
Windows Metafile (WMF)
Enhanced Metafile (EMF)
That means ConvertPS is called up automatically
for opening up files of this format.
Agree to the registration by clicking "Yes".

After the setup has finished installing the program
files, the announcement of this must be confirmed
by clicking "OK".
The installation screen is then closed and the desktop
is available.
ConvertPS is now installed onto your system.
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De-installation (remove)
The de-installation of ConvertPS is practised as usual
on the Windows systems via the dialog window "add/
remove program properties" in the control panel of
the settings.
Note: It is not possible to remove ConvertPS by
placing each of the single program folders into the
recycle bin.

Install/de-install (add/remove)

Select that particular program you whish to remove
from your system in the list, (here: "ConvertPS").
The button "add/remove" is now active. Click this
button to resume the de-installation.

Confirm file delete

The window "Confirm file delete" requires your fi-
nal confirmation to delete the selected application
and  the according components by clicking "Yes".

Remove programs from the computer

Consequently the Uninstallshield is opened and the
program along with the according components are
removed from the system.
Once the Uninstallshield has completed the
deinstallation, acknowledge this by clicking the
"OK"-button and thus leave the window "Remove
programs from the computer" and also the
Uninstallshield.
ConvertPS is now no longer on your system.
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ConvertPS Classic: menu "File"

The menu "File" offers various functions which effect
whole files when selected.

Open...
open the desired PS-, EPS- or AI file and display
the first page of this file as metafile

Open Metafile...
open and display an available metafile

Close
close the currently opened PS-, EPS- or AI file

Close ALL
Close all currently opened PS-, EPS- or AI files

Save As...
save a chosen PostScript file as metafile

Print
set the following print options:

Current Page
print the presently converted page of the current
PostScript file
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ADSC-comments
see also p 58

Print All
print all pages of the current PostScript file

Preview
display a preview of the printout

Page Setup
change the settings of the default printer

Cancel Print
cancel the print job

File Info...
put out information concerning the opened
PostScript file

ConvertPS Batch
call up the program ConvertPS Batch

Exit
end ConvertPS
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Open

This function opens PostScript- and Encapsulated
PostScript files (*.ps,*.eps).
When "Open" is selected, a dialog box of the same
name appears with a selection list consisting of all
files available for opening. By default setting the files
on offer are reduced to those of the formats (*.ps),
(*.eps) and (*.ai). Choose a different file format in
the field "Type of Files "i.e.(*.ps), (*.eps), (*.ai) - for
files of those formats, or "All Files (*.*)" - for all files
availabe, no matter what format. You may open any
file from the list you have chosen. Note though that
ConvertPS can only work sensibly, with either PS-
or EPS-files.
Some PostScript files include so-called ADSC-
comments which give information on how many
pages the PostScript file in question consists of. If
ConvertPS has found such information (which do not
necessarily go conform with reality) the amount of
pages found is displayed in the statusbar. With this
information and the control field "Page..." in the menu
"View" you may display a specific page of the file.
By opening a PostScript- or Encapsulated PostScript
file in ConvertPS the file will immediately be
converted  and  the result displayed as metafile.
This is merely a proposed version though, which you
may alter by choosing other settings and then
converting the file anew. Save whatever converting
result suits your purposes by clicking "Save As" in
the same menu.
The converting process is displayed in a progress
bar at the bottom of the main window.
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Open Metafile

The function "Open Metafile" opens any particular
metafile from the hard disk and views it in the graphic
window of ConvertPS. This function is particularly
useful for viewing metafiles that were converted in
the batch mode.
ConvertPS offers the following options after loading
an available metafile:

- checking the metafile with the zoom function
("View> Zoom")

- printing the metafile
("File > Print > Current Page")

- copying the metafile into the clipboard
("Edit > Copy Metafile")

- saving the metafile in another format,
e.g. as bitmap ("File> Save As")

Close

The function "Close" closes the currently opened
PostScript- or metafile.
ConvertPS has multi-document ability. Therefore it
is possible to have a few files opened at the same
time. It is not necessary to close one when another
one is opened.
It is necessary to close a file when you want to open
and edit it in another application though. This is
because the file is engaged by ConvertPS. It is only
released and thus available for another application
when closed in ConvertPS.
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Close All

If there is more than one file opened You can easily
close all files by usage of the function "Close All".
The program closes the files one after another. If
changes have taken place, which have not yet been
saved the usual question to save these changes will
appear.

Save As

The function "Save As" saves the presently activated
PostScript-, Encapsulated PostScript- or Adobe Illu-
strator file in any output format you choose from those
provided by ConvertPS.
ConvertPS currently supports the output formats:

- Windows Metafile formats: EMF and WMF
- Encapsulated PostScript formats: EPS
- Bitmap formats: BMP, GIF, TIFF and PCX
- Vector formats: DXF, SVG and PDF

Name the file and add the respective file extension
in the dialog box "Save As". Also check if the  target
folder is correct. Exit the dialog box by clicking "Save"
in order to save the current file in the requested
format or by clicking "Cancel" to abort the saving
procedure.
When opening a PS- or EPS file with "File > Open"
ConvertPS will interpret the file before displaying it.
Save the result with "File > Save As" in the format of
your choice. When saving a file in the bitmap format,
the dialog box "Output settings" appears with the
register card "BMP" in which you need to set the
respective parameters.
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Print

The menu "Print" offers the sub-menus

- Current Page
- Print All
- Printer Setup

Current Page

The function "Current Page" prints the metafile
which ConvertPS has created from the latest
opened  PostScript- or Encapsulated PostScript
file. As ConvertPS creates single metafiles from
every single page within a multiple paged
document, the latest metafile is the converted
version of the current page.
Depending on the printer used, additional settings
such as paper supply,  size, memory, and format
are required for printing the metafile. If the
metafile is to be printed into a file, the target file
name is also required. As for the numerous dif-
ferent printers on the market, it is not possible to
describe the print out dialog in general. For help
on the dialogs concerning the printing on your
particular printer, refer to your printer manual or
call up the Windows Online-help.
In any case you have the possibility to stop the
printing of the metafile after the printing process
was started. Click the "STOP" symbol in the
toolbar or "Cancel" in the menu "Edit".
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Print All

The function "Print All" prints all pages of the
currently opened file. If necessary, remaining
pages are converted so that all pages can be
printed in the converted version.
ConvertPS will save these results in a cache. If
any of the pages are called up afterwards, they
need not to be converted again.
Note: The files in the cache are deleted when
the program is closed, as they are not saved and
stored. To do so, call the files up and save them
as described in "Save as".

Preview

The function "Preview" enables you to view the
results of the printout prior to printing.

Page Setup

The function "Page Setup" changes the various
optional settings for the printer, such as the paper
supply, the size and the format. The settings
depend on the features of the employed printer
and cannot be described in general. For help on
this matter, refer to Your own printer manual or
call up the Windows online-help.



29

Functions in the menu "File"

Cancel Print

The "Cancel Print" function aborts the converting
or printing process while in progress. You may
also click the STOP symbol in the toolbar to
achieve the same effect.

File Info

The function "File Info" supplies you with info on the
currently opened PostScript file.
ConvertPS takes these information from the
operating system or the PostScript file itself.
The details listed beneath ConvertPS file information
are provided by the operating system:

File Name
Folder
File Size
File Date
Number of Pages

The other details come from the opened PostScript-
or Encapsulated PostScript file. They are voluntary
entries within the file in question and therefore need
not neccessarily be correct. Often enough the
according display is empty and no information is
available, such as:

Title
Creator
CreationDate
BoundingBox
Pages
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ConvertPS Batch

This function opens the program ConvertPS Batch.
ConvertPS Batch is an independent program for
converting large amounts of PostScript data in the
batch mode.
See also:  ConvertPS Batch

Exit

The function "Exit" closes ConvertPS.
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ConvertPS Classic : menu "Edit"

The menu "Edit" includes the following functions for
editing the current documents:

Copy Metafile
copy the current metafile into the clipboard

Cut
display a selected rectangular cutout of the
metafile in question

Extract Pages
save single pages from a multiple paged document
into a separate file

note: the document must follow the ADOBE Document
Structuring Conventions!
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Copy Metafile

By clicking "Copy Metafile" the current metafile is
copied into the clipboard. The image can be pasted
into other applications and henceforth used and edited
as required.

Cut

By clicking "Cut" the display of the currently visualized
metafile is reduced to a selected cutout. This function
is only available when the function "Clipping" is
activated ("Clipping" is situated in "Output > Vector
Formats" in the menu "Options").

1) Create a selection box around the detail you wish
to cut out.

2) Do this by pointing the mousepointer to one of
the corners of the intended selection rectangle.

3) Hold the left mouse button and by moving the
cursor, you will automatically create a selection
box.

4) It is important that you mark the exact part of
the image you wish to cut out with this selection
rectangle.

5) When you are satisfied with the selection let go
of the mouse button.

A dialog box will appear in which you may confirm
your selection. In case you click "No", you may correct
your selection directly.
Cutouts created this way may be saved in any of the
output formats. They may be imported into other
applications and edited subsequently.
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Extract Pages

By clicking "Extract Pages", single pages extracted
from a multiple paged document (which all follow the
ADOBE Document Structuring Conventions) can be
saved in a seperate file. The document from which
you would like to extract the pages, must be selected
and opened (menu "File", option "Open"). By
subsequently activating the function "Extract Pages"
you are presented with the following dialog box:

Fill in the field "Pages:"with one of the following options

- choose a single page by entering the specific
page number, e.g."10"

- choose any number of consecutive pages by
entering the first and last page number of that
particular selection e.g."15-20". If you leave out
the last figure, then ConvertPS will automatically
insert the last page number of the document.

- choose a variety of pages (i.e. a combination of
the above possibilities) by seperating the details
with a semicolon (e.g."10;15-20;25-")

The pages defined this way can be stored in a
particular predefinable file in the same succession as
laid down in the dialog "Save As". ConvertPS saves
the pages  by using the function box.
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 If e.g. the selection "20;10" was made, page 20 will
be the first to be saved in the target file, only then to
be followed by page 10.
When the first page number is higher than the last
page number when defining consecutive pages,  these
pages will be saved in this, the reverse order:
e.g. if the figures "20-18" were set, then ConvertPS
will save page 20 first, followed by page 19, followed
by page 18.
Thus you can predetermine the structure of the target
file by entering the selected pages respectively.
The separate file (target file) with the selected and
converted extracts (single pages, selected range of
pages) from a PostScript print file may be printed out.
This way you can reduce  the size of an otherwise
massive print file to a print file that merely includes
the desired pages.
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ConvertPS Classic : menu "View"
The menu "View" contains various functions with which
to view a particular page in the metafile format from
the PostScript file currently in use. Most of the "View"
functions commence the conversion. Therefore the
function to "Cancel Conversion" was also situated
within this menu.

Toolbar
display or hide the toolbar

Statusbar
display or hide the statusbar

Interpreter output
display the standard output window of the interpreter

Current Page
display the current page of the currently opened
PostScript file in the EMF or WMF format

First Page
display first page of the currently opened PostScript
file in the EMF or WMF format 

Next Page
display the next page of the currently opened (mul-
tiple paged) PostScript file in the EMF or WMF
format
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Previous Page
display the previous page of the currently opened
(multiple paged) PostScript file in the EMF or WMF
format

Page...
display a particular page of the currently opened
(multiple paged) PostScript file in the EMF or WMF
format

note: this function is only available, when the
document in question is structured according to the
"ADOBE Document Structuring Conventions"
(ADSC).

Cancel Conversion
abort the current conversion process

Zoom
zoom in the selected part of the currently displayed
metafile
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Toolbar

The function enables you to have the toolbar displayed
or hidden as required.

Statusbar

The function enables you to have the statusbar
displayed show or hidden as required.

Info Window

With the function "Info Window" the standard info
window of the interpreter is activated. The information
given in this window could be helpful in case an error
occurrs. All the standard outputs are listed here in
chronological order from the opening of the program
onwards.

Current Page

With the function "Current Page" the current page of
the file is converted once more and displayed again.
This might come in handy when e.g. you converted
only part of the file by using the cutting tool and decide
afterwards you rather had the whole file converted
instead.
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First Page

With the function "First Page" the first page of the
PostScript file in question is converted and displayed.
Hence the converting process starts at the beginning
of the file and ends, i.e. is interrupted as soon as a
page output command appears in the script
(e.g.`showpage) or the end of the file is reached.
When the PostScript interpreter has arrived at the end
of the first page (i.e. the page is converted and
displayed) but not the end of the file, the file remains
open and the function "Next Page" (or the equivalent
symbol in the toolbar) is selectable.

Next Page

With the function "Next Page" ConvertPS is caused
to proceed with converting the current PostScript file
after the latest showpage command. Again ConvertPS
will continue converting until the page is completed,
which once more would be indicated by a new show-
page tag or the end of the file.
The fact that there is still another page in the file to
follow, is indicated by the ability to select the symbol
"Next Page" in the toolbar or the equivalent function
in the menu "View".

Previous Page

With the function "Previous Page" ConvertPS is
caused to precede with the converting for the current
PostScript file at the beginning of the previous page.
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Again ConvertPS will continue converting until the
page is completed, which once more is indicated by a
new`showpage´-tag in the PostScript script or the end
of the file is reached.
The fact that there is a page previous to the one
currently called up, is indicated by the ability to select
the symbol "Previous Page" in the toolbar or the
equivalent function in the menu "View".

Page...

The function "Page ..." enables the selection of a
specific page from a multiple paged document. The
document has to be in accordance with the "ADOBE
Document Structuring Conventions" (ADSC) though.
If it is not, the function is invalid for further procedures.
If ConvertPS recognizes such a structure after opening
the file, the number of pages found to which the
structure applies, is displayed in the statusbar.
Subsequently when the function "Page ..." is activated,
the following option dialog will appear:

Now you can choose any page within the document.
ConvertPS will go to the beginning of that particular
page and convert it.
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Cancel Conversion

The function "Cancel Conversion" enables you to
interrupt and end the converting procedure, no mat-
ter which command initiated the conversion.
Those commands not applying to the current metafile
initiate the converting of the page concerned and are
also stopped when the conversion is aborted.

Zoom

With help of the zoom function you can enlarge details
from a metafile:

 - activate the zoom function in the menu "View" or
by clicking the equivalent symbol in the toolbar.

 - create a selection box around the detail you wish
to zoom.

 - do this by positioning the mousepointer in one of
the corners of the intended selection rectangle.

 - hold the left mouse button and move the cursor
diagonally across - to the opposite corner.

 - once you are satisfied with the selection, let go of
the mouse button.

The selected part of the image will be displayed without
distortion. The degree of the zoom depends hereby
on the size of the selection box and the size of the
window in which the metafile is displayed.
 Press the right mouse button to return to the original
size of the image. As long as the zoom is activated
and has the shape of a magnifying glass, you may
repeat the zoom function as described above as many
times as you wish.



ConvertPS Classic : menu "Options"

The functions in the menu "Options" allow you to
set important features in ConvertPS.

General...
set general parameters

Interpreter...
set parameters for the input

Fonts
determine font settings

Fonts Explorer
Fonts manager

PostScript
determine PostScript settings

Output
set parameters for the output

Vector Formats...
set parameters for the output of vector formats

Bitmap Formats...
set parameters for the output of bitmap formats
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Default
set back to default settings

EMF Mode
switch to "EMF" mode

WMF Mode
switch to "WMF" mode

Import
import settings from .cps files

Export
save settings as .cps file
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General

In the menu "Option" you will find the selection field
"General...". Here you can change 5 default settings,
which apply to subsequent program starts.

The 5 default settings in detail:

Default converting mode

In this field you can decide upon the converting mode
that is to be used when the program is started. You
can find advice on choosing the most sensible
converting mode for your intentions in "Advice..".
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Default target format

In this field you may choose your own default target
format for the function "Save As" in the "File" menu.

Working folder

Here you can establish, which working folder is
opened by default in the dialog box "Open" in the
"File" menu.

Default target folder

This control field enables you to use a target folder
different from the working directory to store the
finished target files. Usually the work is done within
the same folder, therefore the default setting is
"Target folder is working folder". To set a different
target default folder, you need to deactivate this
setting first

HTML browser for help

This selection field enables you to set your preferred
browser to view the user’s guide and help.

Interpreter

With this selection field  the dialog box "Interpreter
settings“ with the register cards 'Fonts' and
'PostScript’  is called up.

Fonts

The register card 'Fonts' consists of a selection
window with all PostScript fonts currently installed
for ConvertPS.



45

Functions in  the  menu "Options"

45

Meaning of icons:

TrueType Fonts

PostScript Fonts

Alias
(Font Substitution)

The currently selected PostScript font is displayed
above the window. Beneath the font selection window
there are the two buttons: "Use as Standard " and
"Font Explorer...".

 Use as Standard

Standardize a font by selecting your choice from
the range of fonts in the selection window and click
"Use as Standard".
The name of the standard font currently in use is
displayed at the bottom of the register card.
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Font Explorer...

The dialog box 'Font Explorer' is called up by
clicking the according button.

In the Font Explorer you can add or delete
TrueType- or PostScript fonts. All PostScript fonts
can be substituted by alias names.
The standard TrueType fonts are "Arial", "Courier
New", "Times New Roman" and "Wingdings" in
various different cuts. For every PostScript font
an equivalent alias font is available.
The operations offered in the register card 'Fonts'
are as follows:

- define new default-font
- install PostScript-font
- install TrueType-fonts
- delete fonts
- assign alias-names
- change alias assignment
- delete alias assignment
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Define new default font

If a font cannot be defined over the installed fonts
nor their alias names, ConvertPS will use the
default font.

Change the default fonts as follows:
- choose the font you wish to standardize from

the list of installed fonts in the selection window
on the register card 'Fonts'.

- click the button "Use as default". The name of
this font appears in the field "Default Font:".

Install PostScript font

How to add one or more PostScript fonts to the
list of installed fonts:

- call up the Font Explorer, by clicking the
according button on the register card 'Fonts'.

- when the Font Explorer is displayed, activate
"PostScript" in "New" from the menu "Edit".
the dialog window 'Add PostScript Fonts'
appears. Choose that directory from which the
intended PostScript fonts are stored on your
system in the option field 'Look in:'.

- mark all those fonts you want to install in the
window "PostScript Fonts:". If there is only one
font activated, this font name will appear in the
field 'File name:'.

- depending on whether or not your choice of
selected fonts is final, leave the window 'Add
PostScript Fonts' by clicking either "OK" or
"Cancel". If you confirm your selection with
"OK", ConvertPS will load every single one of
those fonts. If a font is supposed to be loaded
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allthough a font of the same name already
exists ConvertPS will show a warning declaring
the deletion of the old font by loading  the new
one. You may either agree with "Yes" or deny
the loading with "No" (repeat the selecting
process) or "Cancel" (abort the operation).

Install TrueType fonts

ConvertPS allows you to install TrueType fonts as
substitute fonts for PostScript fonts. This is how
to add a TrueType font to the list of installed fonts:

- Call up the Font Explorer by clicking the
according button on the register card 'Fonts'.

- When the Font Explorer is displayed, activate
"TrueType" in the menu "Edit >New".
The dialog window "TrueType Fonts" appears.

- Select a TrueType font in the selection window
'Font'. select a particular style (standard, italic,
bold, bold-italic) for the font in question from
the list 'Style'.check the currently selected font
in its selected style in the field 'Sample'.

- Repeat these steps until you have found the
desired font.

Note: every style of a font (standard, italic, bold,
bold-italic) needs to be installed separately! As the
TrueType fonts are employed as substitutes for
PostScript fonts you should also take care that
the TrueType font and its equivalent PostScript
font have got as many characteristics in common
as possible.
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- leave the dialog box 'TrueType Fonts' by
confirming your entries with "OK".

ConvertPS will then load the selected font. Click
"Cancel" to abolish your entries.

Note: you will have realized that the name of the
TrueType font created this way is made up directly
from the chosen font and style. It is neccessary to
define alias names in case TrueType fonts are to
substitute unavailable PostScript fonts. How to do
so is describe in the section "Assign alias names"

Delete fonts

You have the possibility of deinstalling one or more
of the fonts installed for ConvertPS. With deleting
the font you will also delete the assignment
between the font and the according alias name -
provided such an alias name was defined.

Note: the operation to delete fonts has of course
no effect on the font files they refer to.

How to delete one or more PostScript fonts:

- mark all PostScript fonts you wish to delete in
the Font Explorer.

- activate "Edit > Delete" in the Font Explorer.
- all marked PostScript fonts will now be

removed from the list. A dialog box might
appear when you try to close the Font Explo-
rer window, if the deletion in question muddled
any of the assignments. The dialog box informs
you  that there are fonts with a faulty assign-
ment and that this can result in converting
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errors. If you wish to contiue despite this
warning, click "Yes". Click "No" to check the
list again and correct it where necessary.

Assign alias names

Text included in PostScript files can only be put
out if a PostScript font is designated to it. In many
cases though these PostScripts fonts are either
not available or have different names.
In the menu "Edit > New > Alias" you have the
possibility to connect an alias name to every
installed PostScript or TrueType font.

This is how to enter a new alias name:

- Select a PostScript- or TrueType font in the Font
Explorer.

- Activate "Edit > New > Alias" in the menu.
(note: a doubleclick on  the font in question has
the same effect as these two first steps)
 the dialog box 'Alias' appears, in which the
name of the selected font is displayed. Enter
the desired name into the entry field 'Alias
name:'.

- Leave the dialog box 'Alias' with "OK", thereby
confirming the new alias name or click "Cancel"
to abolish it.

The new alias name appears on the alias list under
'Font name' in the Font Explorer with according
counterpart registered under 'Assignment'.
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Change alias assignment

how to change the assignment of a certain alias
name to a specific PostScript font:

- Doubleclick  the alias font of which you want to
change the assignment in the Font Explorer.

- The dialog box 'Alias' appears, in which the
selected font and its currently appointed
TrueType- or PostScript font is presented.
Change the alias assignment by selecting a
different element from the list featured in the
'for font:' field.

 - Leave the dialog box 'Alias' with "OK", thereby
confirming the new alias name or click "Cancel"
to abolish it.

The new alias name appears on the alias list under
'Font name' in the Font Explorer. The according
counterpart is registered under 'Assignment'.

Delete an alias assignment

how to delete the assignment of an alias:

- Select the alias font in the Font Explorer of
which you want the assignment deleted.

- Click "Edit > Delete" in the menu.

Note: this operation merely deletes the connection
i.e. the alias font appointed by this connection.
The TrueType- or PostScript font allocated to this
alias name remains an installed font. If the option
"Interpreter..." is selected, the register cards 'Fonts'
and 'PostScript' will appear.
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PostScript

In the register card 'PostScript' you can set all
parameters that are relevant for the converting of
PostScript. Please note, that all changes on the
settings are stored directly in the registry of Windows
95 or Windows NT.

‘PostScript’ also offers various setting options which
promise to be interesting especially for the Post-
Script experts amongst you:
Here you may adjust e.g. the interpreter settings in
general, configure the memory management or
predetermine special limits and values.
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General

In the register card 'PostScript' offers the following
interpreter settings in general:

Display PostScript commands

In case you want to see the PostScript commands
read by ConvertPS on screen, then activate the
option "Display PostScript commands" in the first
control field. The PostScript commands will be
displayed additionally to the standard output in the
"Info Window".
The PostScript commands are usually invisible to
the user. If an error causes the abortion of the
interpretation it is important to be able to check
out the PostScript commands in order to find the
error.
Please note though that an activated display can
reduce the performance of ConvertPS, even if the
info window is not displayed on screen!

Allow file access

In the second control field you can activate or
deactivate the option "Allow file access".

Note: Before activating this option you should be
aware of the fact that the language of PostScript
Level 2 also includes commands such as "Delete
File" and "Rename File". Consequently the
interpretation of a single PostScript file could
destroy the complete file system of the computer.
"Allow file access" is not allowed as default setting.
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Emulate Level 1 PostScript interpreter

If you activate the control field "PostScript Level
1" the Level 2 PostScript interpreter will emulate
the Level 1 PostScript interpreter. This way
PostScript errors specific to Level 2 may be
detected.

Parse ADSC comments

The control field "Parse ADSC comments" is
activated by default. This setting is recom-
mendable for all PostScript documents which
answer the ADSC guidelines. These kinds of
documents can be interpreted page independently,
as all the globally used objects (e.g.fonts) need to
be defined page overlapping.
Is the control field "Parse ADSC comments"
activated, the interpretation of a multiple paged
PostScript file is limited to the global definitions
and otherwise only to the objects defined on the
current page. For example: if you have a document
consisting of three pages and have a font defined
on page 2 which is also used on page 3, then  this
particular font on page 3 cannot be interpreted
correctly.
Yet the correct interpretation can be ensured
none the less by using this trick:

- deactivate "Parse ADSC comments"
- open the file anew and then interpret all three

pages again one after the other. Thus the locally
defined fonts from page 2 are still available on
page 3.
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When "Parse ADSC comments" is deactivated, it
is not possible to visualize one page in particular,
as details on page numbering are implied in the
ADSC comments. But this is the only way to
visualize multiple paged PostScript files with faulty
ADSC comments at all.

Close files automatically

It might be sensible in some cases to activate the
function "Close files automatically" when conver-
ting PostScript files. As soon as a new page from
the currently opened PostScript document is
displayed (and interpreted at the same time), the
PS file is closed and reopened automatically.
Imagine you have access to a PostScript file
somebody else is working on at the same time: is
the function "Close files automatically" activated,
you will be updated on any alterations every time
you change the page.

Note: This function cannot be activated for the
currently opened document. If necessary open the
current document anew.

Garbage collection

"Garbage collection" enables you to decide if,
when and which storage areas are to be 'tidied
up'.
The settings "On" and "Only global" activate the
garbage collection when a certain percentage of
virtual memory is occupied.
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Local memory

In the field "Local memory" you can determine the
initial size of the local memory between 2.500
KByte and 80.000 KByte.The prescribed size of
the local memory is dynamically increased as
required until the maximum size (set in the field
"Maximum local memory") is reached. Should the
allocated memory still not be enough for the
conversion of a PostScript file, ConvertPS will
abort the conversion with the error message
"VMerror".

Maximum local memory

The maximum size of the local memory can be
determined in the field "Maximum local memory".
The size of the local memory cannot exceed this
value dynamically. Should the error "VMerror"
occur, you should increase this value.
The maximum local memory can also reach
80.000 KByte at most.

Maximum path length

The paths used by PostScript for drawing and
clipping are only supported up to a certain length
in order to preserve resources. Should the error
"Path overflow" occur you can increase the value
for the maximum path length - in most cases this
will solve the problem.
You may enter a value between 2048 and 20480
in the field "Maximum path length".
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Maximum stack size ('Limits')

By default the three stacks used by PostScript are
supported only up to a stack-typical, sensible size
in order to preserve memory. Should a "Stack
overflow" error occur anyway, you may increase
the maximum length of the operand-, the
dictionary- and the execution-stacks in the fields
of the equivalent names and thus solve the
problem.
- The operand-stack

can consist of 2048 up to 7132 elements,
- the dictionary-stack

of 128 up to 384 elements and
- the execution-stack

between 512 and 1536 elements.

Output...

"Output..." in the menu "Options" offers you the choice
of two dialog boxes in which to set the parameters for
either the vector formats or the bitmap formats.
At present ConvertPS can create the output formats:

     - EMF, WMF, EPS, DXF, SVG and PDF (vector)
- BMP, GIF, TIFF and PCX (bitmap)

(By clicking the "Output..."symbol in the toolbar you
will receive a dialog box called "Output setting". This
dialog box offers you register cards for each possible
output format. There is no special classification in
vector or bitmap formats.)
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Vector Formats

If you choose the dialog box 'Vector Formats' after
"Output" in the menu "Options" you will be presented
the dialog box titled 'Vector format settings', with the
register cards 'EMF', 'WMF' and 'EPS'.
The settings are all listed in the frames "General" or
"Bitmaps". Beneath these frames you will find the
remaining option as well as the keys for setting the
pageformat.

General

The settings listes in the frame "General" are not
the same or not available for all formats.
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- "Activate clipping" applies to all 3 formats
- "Transform text into paths" only available for

EMF, WMF, DXF, SVG and PDF.
- "Windows 95 EMF-format" is reduced to EMF

the option for WMF here is "include PostScript".
- "Use defined colours" is only available for EMF

and WMF.
- Using DXF You can choose, if You like to get a

selection dialog and if lines shall be transformed
into paths. Activated by default.

- With PDF You can choose, if You want to
include PostScipt comments. Deactivated by
default.

Activate clipping

When the option "Activate clipping" is activated,
ConvertPS will evaluate the clippaths of the
PostScript file on converting and only then the
'initial clippath' will be included, too. The 'initial
clippath' describes a virtual page format, which is
prescribed to the interpreter. When "Activate
clipping" is activated, this page and everything on
it will be interpreted and displayed, everything else
is left out.
Due to the fact that the evaluation of clippaths is a
matter of intensive computing, it is sensible to
deactivate this option at most times and renounce
the results of the clipping.
"Activate clipping" is deactivated by standard
default for all vector formats.
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Transform text into paths

With the control field "Transform text into paths"
you can determine whether you want to have the
text transformed into paths (i.e. graphic image
elements such as lines, filled polygons etc.) or into
the text output commands specified by the WMF
format.
Some applications can import WMF files but are
not able to interpret metafile text output formats
correctly.
For these applications the 'transformation of text
into paths' is necessary. In general, this option is
deactivated because the 'transformation of text
into text output' command uses less memory and
calculating time than the 'transformation into paths'
command.
"Transform text into paths" is deactivated by
standard default.

The third option for setting the parameters are diffe-
rent for each vector format:

- the settings for the EMF format offer the option
called "Windows 95 EMF format".
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- the alternative for WMF is "Include Post-Script". -
- the only option available at all for EPS is "Activate

clipping“
- If You use DXF, You can choose, if You want to get

a selection dialog and if lines shall be transformed
into paths. These two options are activated by
deafault.

Windows 95 EMF format

"Windows 95 EMF format" is the option only
available and useful for the EMF format.
When converting PostScript files on an NT system,
the files are generated for this operation system.
These files are not Windows 95 conform.
Windows 95 merely supports EMF to a certain
extent, as EMF was not originally designed for this
operation system. So in case you convert
PostScript files to EMF files on an NT system and
subsequently want to use them on a Windows 95
system, the conversion needs to be performed in
favor of Windows 95. The option "Windows 95
EMF format" offers the opportunity to simulate
Windows 95 on an NT system. Thus CovertPS
will restrict the conversion to fit the capability of
Windows 95 regarding EMF. EMF offers a lot of
advantages and features which only those
applications can make full use of, which support
EMF in its entirety such as Windows NT. Yet due
to the restriction of an EMF file owing to the nature
of Win95, some of the EMF features are lost
Windows NT. Hence the specific NT-capabilities
for EMF cannot be applied any longer. Then again
this option is the only possibility to view and use
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EMF files on Windows 95 systems at all.
As this option is only needed for the specific
pupose described above, this option is deactivated
by default setting.

Include PostScript

When converting to WMF or EMF, the option
"Include PostScript" enables you to embed the ori-
ginal PostScript code in either output format.
This function is most interesting, when images are
supposed to be processed further. The converted
file can be printed out on PostScript printers (the
PostScript code is embedded) and also viewed in
your application on screen (the application can
display the format chosen for the conversion). This
way you avoid loosing any information by
converting and have the greatest benefit from it.
"Include PostScript" is deactivated by standard
default, simply to narrow down the size of the
created file.
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Transform lines into paths

Using this option in DXF fomat You can decide, if
lines shall be transformed into paths in the
currently opened file. This means, that by
presentation of lines these shall be regarded as
areas in respect to line thickness and if these lines
shall be printed.

Insert PostScript comments

This option can be used in PDF format. It achieves
the production of an index with help of the
informations in the PDF-file. During the view of
the file stored in pdf format with AcrobatReader
an inex with comments is available.

Use defined colors

The control field "Use defined colors" can be
activated with either EMF or WMF as the chosen
output format.
Is the option "Use defined colors" activated,
ConvertPS will only use these for the output of
the colors from the PostScript file but will seek
out the one color from the defined palette which is
closest to the original.
Currently up to 16 colors may be defined.
Consequently the number of colors used is
reduced down to 16 when creating a metafile.
Depending on the color definition grey scale
images or black-and-white images can be
generated.
"Use defined colors" is deactivated by standard
default.
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Show defined colors

To view the userdefined colors :
Activate the control field 'Use defined colors'.
The button "Define colors" situated underneath
can now be activated and the dialog box 'Color'
will appear. You will find 16 color boxes beneath
the heading "Custom colors".

Note: The color boxes are always filled, even if
you have not yet defined any colors yourself. When
you define your own colors you simply replace
those in the color boxes by clicking the button
"Define Custom Colors“ .
On the right hand side a color matrix and a color
bar is added to the dialog box. The color selected
in "Custom colors" appears both in the color matrix
and color bar and additionally in the field
"Color|base".
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Alter the color displayed in "Color|base" until it is
to your satisfaction:

- You can create any color directly by entering
the respective values for the additive color
components (red, green, blue).

- You may also choose a color from the color
matrix and the shade in the color bar.

- Furthermore you can choose a color from the
palette offered under "Basic colors" and adjust
it with the previously mentioned options.

When you have found the desired color, click "Add
color", and this color will replace the one in the
selected color box.
 Repeat these steps until you have defined up to
16 colors.Click "OK" to confirm the new settings
or "Cancel" to delete them.
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Bitmaps

In the frame "Bitmaps" the options "Transform
bitmaps into paths" and "devide Bitmaps into
stripes" are available for all bitmap formats.
Especially for the EPS format the option "create
binary data" is available.

Transform bitmap into paths

"Transform bitmap into paths" enables you to
convert bitmaps into paths i.e. bitmaps depicted
onto filled polygons. The 'transformation into paths'
is necessary in case the bitmap is to be altered by
clipping in any way. The clipping only works with
images made up of polygons, hence the bitmap
needs to be transformed into a vector image i.e.
paths. This transformation uses a great deal of
memory and is time consuming. The resulting file
itself is also very large. Therefore this option need
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not be activated except for that specific purpose.
Please remember to tick "Activate clipping" at the
same time, otherwise there is no point in the
transformation.
"Transform into paths" is deactivated by standard
default as the use is limited to the specific purpose
described above. The options are not availble for
the formats DXF, SVG and PDF.

Create binary-data

When setting the parameters for the output of EPS
you can activate the control filed "Create binary
data". ConvertPS will then convert all the image
data of the PostScript file from a hexadecimal to
a binary presentation. If your print server supports
binary coded image data, the amount of image
data can be reduced by half.
"Create binary data" is deactivated by standard
default, as the use limits the portability of the
created file. The options are not availble for the
formats DXF, SVG and PDF.

Divide bitmap into stripes

The vector formats EMF, WMF and  EPS may be
divided into stripes by ticking the appropriate field:
"Divide bitmap into stripes".
When you have activated this specific control field,
ConvertPS will divide the PostScript file into
stripes. Hence the conversion will take place stripe
by stripe, enabling your system to digest even very
large and computing intense bitmaps which would
otherwise bust the graphical interface of the
system.
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This setting is not neccessary for smaller bitmaps
- on the contrary: it would increase the time needed
for the whole procedure and should therefore be
switched off.
In case you have activated "Divide bitmap into
stripes" you may enter the width of the stripes
(between 32 and 32.000 Kbyte) in the control field
beneath.
The options are not availble for the formats DXF,
SVG and PDF.

Further options for setting the parameters

   

The remaining options for setting the parameters
on the registercard refer to the way of displaying
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the file in question. The options herefore are:

- page format (button for seperate window)
- scaling
- number of straight lines in curve approximation
- rotation
- minimal linewidth

DXF format coordinate system

On the register card for the DXF format the functions
"Scaling" and "Rotation" are available. For Scaling
You can specify the size of the represented picture.
For example a setting of "2" provides an enlarge-
ment of the factor 2, the image will be of double
size. The default setting is "1"to display the original
size.
For Rotation of the objects You can set angles
between 00 to 3600 degrees. The default setting is
00 degrees to display a picture of the original.
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Page format

You can set parameters for the page format for all
vector formats.
ConvertPS uses the specified page format
parameters for the converting of PS-files as well
as for the creating of the metafiles. See below
how to set the parameters for the page format:

Measuring unit

For "Unit" You can select the unit of measurement
for the page format. You can chose between
"mm","cm", "Points" and "Inch".
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Format

For "Format" You can chose between the diffe-
rent DIN-Formats, e. g. DIN A 1, DIN-A 4.
ConvertPS refreshes automatically the referring
values according to "Width" and "Height". If you
chose "Default" and the unit of measurement
"Points", You get a coordinate system with the
origin (-1000; 1000) and with height and width of
2000 points.
For the format "Printer" the page format settings
will be automatically adjusted to the settings of
the installed printer.You may also specify the
values for "Height" and "Width" yourself. In this
case "User" will be the selected format. Finally
You can chose between the vertical or horizontal
orientation of the page by activating "Portrait" or
"Landscape".
The control field "Set bounding box to page format"
is an additional function in ConvertPS.
This function enables you to define the bounding
box yourself, by defining the page format. This is
e.g. very useful when the positions of the contents
of a PostScript file is unknown. Usually the
bounding box presents the contents of a PostScript
file to fit the box, i.e. the display window exactly.
By setting the bounding box to the page format
you decide on what the bounding box displays and
define that particular area with the values set in
"Origin" and "Size" (or opt for "Default" in "For-
mat"). Thereby you can have the largest possible
area displayed. Hence you can survey and locate
the positions of each object that is included in the
file. By setting new values for "Origin" and "Size"
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relating to the previously set coordinate system
you can work your way toward the desired object
until you have targeted the specific cutout.
If this option deactivated, ConvertPS will calculate
the bounding box itself. It is then sized down to
the smallest possible rectangle to surround all
objects. This bounding box is independent from
any coordinate system as the objects in question
are placed into the box instead of the box
displaying a particular section of a coordinate
system.
Should the settings in page format be ignored, it
might be that the native PostScript code includes
a ‘setpagedevice’ command. If such a command
exists, the page format will be ignored and the
values allocated to `setpagedevice applies. The
information window will tell you if there is such a
command and if so, what the parameters are.

Note: For the settings for the page format please
be aware, that ConvertPS only converts the
objects, that are placed in the chosen page format.
For example by selecting the DIN A4 page format
for a PS-File with a DIN A3 image ConvertPS
converts only a part of this image - the part, that is
placed on the DIN A4 format - and creates
metafiles. In case the selected page format is
larger than the source PS-object ConvertPS
converts the image with a blank rim. ConvertPS
stores the page format settings in the registry data
base and uses these settings for the next pro-
gram start. The default page format setting is DIN
A4.
For additional information about page format
settings see also "Tips".
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Set scale factor

Just like the option page format You can specify
the size of the graphic to be created of all vector
formats except the DXF format, too. In the option
"Scaling" You can set a scaling factor in per-
centage (%) according to the original size of the
source document. With this You can minimize or
maximize the measurements of the graphic to be
created relating to the measurements of the origi-
nal. The scaling factor effects the x-coordinate as
well as the y-coordinate. For example the scaling
factor 50 % reduces the graphic to be created to
a quarter of its original size.
By default a scaling factor of 100 % is set to display
the document in its original size.

Set straight lines in curve approximation

The field "Straight lines in curve approximation"
allows you to set the number of straight lines that
are to be used to depict a curve. Obviously the
curve is smoother, the more straight lines are
included in the approximation. Unfortunately the
converting time rises proportionally with the
number of lines used. Therefore it is up to you, to
find a most suitable compromise between the
smoothness of the curve and the converting time.
Remember to take the resolution of the output
device into account when deciding on the number
of straight lines in the curve approximation.
The default setting of 8 straight lines has proved
favorable for most PostScript files for both the
screen display and the print.
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Set rotation factor

For all vector formats You can set an angle of 0
degrees to 3600 degrees in the option "Rotation".
ConvertPS rotates the picture of a PS-file during
converting. The rotation takes place counter-
clockwise.
By default a rotation of 00 degrees is set (no
rotation).

Set the minimal linewidth

For all three vector formats you can set the
narrowest linewidth (in points) in the field "Mini-
mal linewidth". This is the factor, ConvertPS is not
to subside when creating a metafile. All lines that
are thinner than the set value are depicted
stronger.
By determining a relatively strong minimum
linewidth, the quality of the display on screen e.g.
can be improved in case of a relatively low screen
resolution.
The default setting of the minimal linewidth is 0,
so that all lines are put out unchanged.
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Settings for file format DXF

Selection dialog

You can chose the DXF format register card under
Options>Output>Vector formats. Click the button
to activate the selection dialog in the field "Gene-
ral". If You want to save a file in the DXF format
and have activated the selection dialog the
following window appears:

In this window all colors used in the current
document are listed. On the left side the button
appears. This symbol means, that the referring
color shade will be considered for saving of the



76

CLASSIC

76

file.You can deactivate the symbol with double-
clicking on the symbol. Now the referring color
will not be saved. With this selection of colors You
can save parts of a document.

Default settings

If You click on the button "Default" the following
dialog box appears:

In this dialog box You can specify how You want
to present line ends and line joins. Activate the
options by clicking the referring buttons. For line
ends You can chose between "cut", "round" or
"quadratic". For line joins You can select "miter",
"round" and "bevel".
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Line ends

For selection of line ends three possibilities: cut
round or quadratic. If You select "cut" the line will
be cut off after the last point.

If You select "round" the area of a circle will be
added to the line so that it gets a round appear-
ance.

If You select "quadratic" there will be a square
drawn around the last point of the line of which
two opposite sides are parallel to the tangent to
the line.

If You additionally activate the button "Settings for
fix" these settings will not be changed by
converting a new document. The setting "round"
is activated by standard default.
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Line joins

With this option You can determine the graphical
presentation of the join of two lines. With the
settimg "miter" the outer border of two lines will
be drawn on.

  "miter"

With the setting "round" the outer border of the
line join of two lines will be rounded.

  "round"

With the setting "bevel" the outer border of the
line join of two lines will be cut off.

"bevel"

Here it is possible to click the "Settings for fix"
button, too.
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Marker radius

It can happen, that lines which occur in some
documents do not pass into another continuously.
ConvertPS smoothens this transition and shows
You with a small circle the point at which the
smoothing has taken place. This circle is called
marker. The radius of this circle can be set here.

Maximum radius of curves

Every line is presneted graphically as a circle.
Straight lines play a special role for theit own
presentation. Usually straight lines are defined as
a circle with radius moving towards infinite. Since
numbers against infinite are not presentable on
computers the curve radius will be chosen as big
as the presentation does not show any difference
between a straight line and a circle line. These
maximum radius can be set here, by standard a
value of 25000 mm is set.

Curve correction

With Curve correction we describe the suppres-
sion of single deviations. In the text field "Curve
correction up" You can determine from which value
the curve correction will start for all deviations
which deviate more than the entered value.

Set minimum line strength

See Chapter "Classic>Options - Set minimum line
strength.
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Curve approximation

Here You can determine the number of bases for
curve approximation. The value shall be chosen
high enough to ensure a most possible presen-
tation of the curve. It shall be recognized, that the
calculation time rises with increasing number of
bases. The default set of 8 bases has proved
favorable for most PostScript documents.
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Bitmap Formats

If you choose the dialog box "Bitmap Formats" after
"Output" in the menu "Options," you will be presented
the dialog box titled 'Bitmap format settings' .with
the register cards 'BMP', 'GIF', 'TIFF' and 'PCX'.

The register cards offer the following settings for
the output of the bitmap formats:

Set size

The current size of the bitmap in question is
displayed in the fields "Height" and "Width". This
size derives from the format of the metafile (i.e. to
suit the bounding box). You may change these
figures according to your requirements but only if
the option "Default size" is deactivated. The image
that is to be created is then scaled to this size.
Enter the required size in the spaces for the
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"Width" and the "Height" or change the resolution
(see control field top right). The size can be
measured in "mm", "cm", "Points" or "Inches" (as
offered in the control field 'Unit') or in pixel -
depending in which line you fill in the spaces. The
value of the other two spaces is calculated
automatically in respect to the current value of the
resolution. Correspondingly, the height in inch
results from the height in pixel and the resolution
(dpi = dots per inch).
If you want to preserve the ratio of the image, tick
the option "Keep ratio". Depending on which value
you set, the other will be calculated according to
the ratio, i.e. when you set the width, the height
will be adjusted automatically and vice versa.
If you want to go back to the original size, tick the
option "Default Size". The default setting for both
the height and the width of a bitmap is 1 inch. This
accounts to the number of 75 pixel at a default
resolution of 75 dpi.
The default screen resolution is 75 dpi. Should
you require a higher resolution for the bitmap you
want to create, you may raise this value to up to
500 dpi (a standard value is 300 dpi). Note that on
the one hand, a higher resolution improves the
display on screen but on the other hand uses up
more memory (quadratic increase).
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Set color resolution

The number of colors used to create the bitmaps
can be set in the control field "Color resolution"
for all bitmaps formats. the following options are
on offer:
2 grey scales: monochrome (black/white image)
16 grey scales: change to 16 grey scales
256 grey scales: change to 256 grey scales
16 colors: reduce to 16 colors
256 colors: reduce to 256 colors
TrueColor: 16 Mio. colors (not in the GIF format!)

Note: the number of actually creatable different
colors depends also on the current screen mode of
your specific graphics card. If your screen mode only
allows 16 different true colors, only max 16 colors
can be set in the "Color resolution" option, i.e. the
settings "256 Colors" and "True Colors" can only
depict up to 16 colors. All other colors are simulated
by dithering.

Set compression

When setting the parameters for the BMP-, the
TIFF- and the PCX- formats, you have the
possibility of reducing the required memory by
compression.
This option is not available for the GIF format,
simply because a conversion to GIF implies an
efficient compression itself (LZW compression
after Lempel Ziv Welch).
For the BMP- and the PCX format you may
activate a so called "RLE compression". The RLE-
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compression (Run Length Encoding) comprises
successive points with equal color values.
Depending on the color resolution either the RLE8-
(8 Bit per pixel) or the RLE4- (4 Bit per pixel)
method of compression is used.
For compressing the TIFF format the following
alternatives are applicable:

- no compression
- Pack Bits: Run Length Encoding

(equivalent to RLE compression)
- LZW: efficient compression after Lempel Ziv

Welch

When compressing the TIFF format, the image
data is saved in horizontal stripes, whereby each
stripe -except for the last one- includes the same
amount of image lines. Additionally to the type of
compression, you may also set a value for the
width of these stripes. Enter the desired value in
kByte in the field "Stripe width".

Set format

The register card, on which you can control the
settings for the GIF format, you will find the field
'Format' instead of 'Compression' as on the other
register cards
Here you can choose the particular GIF version,
"87A" or "89A". The GIF version GIF89A (intro-
duced in july 1989) is compatibel with version
GIF87A (introduced in may 1987), but consists of
additional i.e. extended graphic items.
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As the GIF format can take in more than one image
(not supported by this module), it is possible to
arrange for a global palette for all included images.
This technique is common with single images, too,
and preferred to local tables. When you activate
"Global color table", a global color table will be
generated.
Another special feature provided by the GIF format
is the ability to store images interlaced. This is
done by ticking the box "Lines interlaced". The
image is devided into 'leaps' of 8 lines each and
then saved staggered. This method allows a
relatively early preview of the complete image
during its transmission, wich is refined in the
progression.

Default

When you activate "Default" in the menu "Options",
all settings for the interpreter and the output
formats are set back to the default settings.
These default setting have proved favorable for
converting most PostScript files. At least they offer
a good starting point for your own parameter
settings.
You should also fall back on the default settings
when you have received unwanted results with
your own settings, especially if you cannot
recognize a connection between them and the
behavior of the interpreter.
When you activate "Default" a dialog box will
appear in which you can either confirm the default
settings or abort this procedure with "No".
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EMF Mode

You activate the converting mode EMF by clicking
"EMF Mode" in the menu "Options".
The chosen mode is then marked by a tick.

WMF Mode

You activate the converting mode WMF by clicking
"WMF Mode" in the menu "Options".
The chosen mode is then marked by a tick.

Note: Advice on how to choose a converting mode
can be found in the chapter "Advice...".

Import

This option enables you to open a file with predeter-
mined settings. These files are created in "Export" and
have the endings (.cps). By opening such a file, the
saved settings for "General", "Interpreter" and "Out-
put" are activated.

Export

This option enables you to save the certain settings
for "General", "Interpreter" and "Output" in a file (.cps).
Hence you can reactivate these settings any time you
like. By the way you can also start ConvertPS by
double-clicking a .cps file.
Moreover these files are compatible with both
ConvertPS Batch and ConvertPS Classic.
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ConvertPSClassic: Toolbar

ConvertPS offers a tool bar for even faster selection
of various service functions.

The functions are represented by the following icons
in the tool bar:

open a PS-, EPS- or AI-file for conversion

open and display an existing metafile

save a selected PostScript-file as metafile

print the converted page of the PostScript-file in
question

display information on the presently opened
PostScript file.

display the info window for the PostScript
standard output.
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zoom (i.e. enlarged) and display the selected part
of the present metafile.

convert  the selected PostScript-file and copy the
thereby created metafile into the clipboard.

cut out the selected area from the current display
(and repeat the conversion reduced to this cut-
out. This option is only available with clipping)

update (renew) the display of the current page
of the presently opened PostScript file in the
EMF- or WMF format.

display the first page of the PostScript-file in
question in the EMF- or WMF-format.

display the previous page of the PostScript-file
in question in the EMF- or WMF-format (only with
mulitple paged documents).

abort the conversion or the current printing job

display the next  page of the PostScript-file in
question in the EMF- or WMF-format (only with
mulitple paged documents).

display a particular page of the PostScript-file in
question in the EMF- or WMF-format
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set the general parameters

set parameters for the input

set parameters for the output

info on the current ConvertPS version
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ConvertPSClassic, -Butler: Statusbar

At the bottom of the active graphics window,
ConvertPS Classic and ConvertPS Butler offer a
statusbar, to give a quick survey of the current
settings.

The items on the statusbar from left to right refer to
the following settings:

to get help, press F1

short help on the objects beneath the mousepointer
or buttons.

The remaining buttons show whether the according
functions are switched on or off by the position they
are in. The pressed-in position means the function
is switched to "on".

EMF

image format (EMFor WMF) of the present
image (EMF in this example )

Clipping

Clipping on or off
(switched to "off" in this example)

BBOX

set bounding box as the page
(switched to "on" in this example)

ClMenOption.html#EMF-Konvertierung
ClMenOption.html#WMF-Konvertierung
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TEXT

direct text output
(switched to "on" in this example)

ADSC

parse ADSC comments
(switched to "on" in this example)

P 1

displays the page number of the current multiple
paged PostScript file

ClMenOption.html#Text_in_Pfade
ClMenOption.html#Text_in_Pfade
ClMenOption.html#ADSC-Kommentare
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ConvertPS Batch

Converting in the Batch mode

ConvertPS offers the opportunity of converting
PostScript files in the batch mode. The whole process
of converting large amounts of PostScript data or a
complete list of files is automised, subsequently
simplifying and reducing the workload for the user.

You can run ConvertPS in the batch mode by
choosing the option "File>ConvertPS Batch" from the
menu or by calling up ConvertPS Batch directly (i.e.
instead of ConvertPS Classic).
Consequently the ConvertPS Batch editor will be
displayed:
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ConvertPS Batch Editor

The main window of the ConvertPS Batch editor is
set up like the explorer. The list presented is initially
empty.
This list must be created first, i.e. filled with the
PostScript files that are to be converted in the batch
mode. The entries required include the source file
and path of each entry, along with the target folder
and target format.
How to proceed with creating such a list, editing it
when necessary and finally converting it, is explained
in the chapter "The Batch mode" following the
description of the various menu options

- File
- Edit
- View
- Options

and their functions.
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ConvertPS Batch: menu "File"

The options offered in the menu "File" within
ConvertPS Batch are:

New

for opening an empty list in order to fill in all files
that are to be converted.

Open

for opening Batch-lists with  the acronym *.cbl.

Save

for saving Batch-lists as *.cbl-files

Save under

for selecting the folder under which to save the
Batch-list as *.cbl-file.

1, 2

for opening the two most recently called up files
anew by clicking either one listed here.

End

for closing down the program
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ConvertPS Batch: menu "Edit"
The options offered up here all refer to either the list
that is about to be created or the various entries.

New

This function refers to the entries in the list about
to be created. In order to add a file to the list it has
to be opened via this function. Hence the dialog
"open", is opened in which the desired file can be
selected. After confirmation of the selection with
"OK" it is added to the list.

Open

This function refers to the opening of already saved
Batch-lists (*.cbl). These can also easily be
"dragged and dropped" from the Microsoft Explo-
rer into the ConvertPS Editor where they open
automatically.

Cut out

This function refers to the selected entries in the
currently opened list. When this functon is applied,
the files selected in the list are cut out and placed
into the clipboard.

Copy

This function refers to the selected entries in the
currently opened list. When this functon is applied
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the files selected in the list are copied and placed
into the clipboard.

Insert

This function refers to the selected entries
previously cut out or to copied files. With this
function these files are added to the list.

Delete

This function refers to the selected entries in the
currently opened list. When this function is applied
the files selected from the list are deleted and
hence removed from the list.

Select all

This function automatically selects all files listed in
the currently opened Batch list. Further advice on
selecting files is given at the end of this chapter.

Target folder

This function sets the target folder for the selected
PostScript file. Via  the window "open folder" which
is called up by this operator, you can choose that
folder in which the file is to be saved as metafile.

Target format

With this function another pull-down-menu is
opened, in which the available target formats are
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recorded. The target format for selected files from
the list, i.e. which they are supposed to be
converted into, can be chosen from these available
formats.
The formats are:

- EMF, WMF, EPS, DXF, SVG and PDF (vector)
- BMP, GIF, TIFF and PCX (bitmap)

Before any of the entries from the list can be
converted, a target format must be allocated to
each.

Start conversion

With this function the conversion process of the
currently opened list is started. Each of the source
files in the list must have an individual target format
and target folder assigned to it. ConvertPS then
commences with the automatical conversion of all
files stated in the list: Each file converted to the
individually assigned target format and then saved
in the assigned target folder.
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ConvertPS Batch: menu "View"
The menu "View" offers the options toolbar and
statusbar, which can be displayed on screen by
choosing them here.

Toolbar

By choosing this function the toolbar is displayed
on screen. The icons and their equivalent
functions on the toolbar are as follows:

New (menu "file")

Open (menu "file")

Save (menu "file")

New entry (menu "edit")

Cut out (menu "edit")

Copy (menu "edit")

Insert (menu "edit")

General (menu "options")

Interpreter (menu "options")

Output (menu "options")

Start (menu "edit")
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Abort

Info (menu "?" )

Statusbar

By choosing this function the statusbar is
displayed on screen. It shows information on the
currently converted file, e.g. the filename and
 the page.

ConvertPS Batch: menu "Option"
The parameters in the menu "options" are identical
to those offered in the program Classic.
Yet in contrast to the ConvertPS Classic menu the
options offered in the ConvertPS Batch menu refer
to CBL-files, i.e. lists of PostScript files and /or sin-
gle elemenst of these lists  and not to metafiles or
the content of metafiles.
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The Batch mode:
The following describes how to create, to edit and
finally how to convert a list of files in ConvertPS Batch.

Create a ConvertPS Batch list

After starting ConvertPS Batch, the displayed list is
initially empty. All the PostScript files due to be
converted must be entered into the list.
This is how to do so:

New list

Open the dialog box "Open" by activating "New"
in the menu "Edit" or  in the context menu (keep
hold of right mouse button). You may also click
the according icon in the toolbar or simply
doubleclick "<New entry>" in the list.

Source file

Choose a folder in which PostScript files are kept
on your system in the option field "Look in:". Now
choose a PostScript file and open it with "Open".
The dialog box is closed and the chosen file then
appears as the last entry on the list. The current
path of the according source file is registered
under "Source file". The second column of the
list shows the target folder in which ConvertPS
Batch saves the created metafile when finished.
At first ConvertPS will proposition the default
target folder registered in "Options > General...".
Choose a folder in the dialog window "find" in
which PostScript-files are kept on your system.
Now select a Post-Script-file within this directory
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and leave this window via the "open" button.
Hence the selected file will appear as the last
element in the ConvertPS Batch list. The current
path of the source file is stated in the column
named "source file".

Target folder

Enter the name of the folder in which ConvertPS
Batch is to save the created meta file in the
column "target". First the standard-target folder
will appear as registered under "options >
general...". To set a different target folder, open
the dialogbox "open directory", in which you
select the belonging source file and then activate
the function "target folder" either in the menu
"edit" or in the context menu. You can also
double-click on the name of the default target
folder. Now select the desired directory from
those listed in this dialogbox and confirm this
choice with "OK".

Target format

In the column "target format" enter the format in
which the created metafile is supposed to be
saved. First the standard- target format will
appear as registered under "options > general...".
Continue as follows to set a different target
format: select the belonging source file and then
activate the function "target format" either in the
menu "edit" or in the context menu.
You can also doubleclick on the name of the
currently set target format. Forthwith a selection
box will be displayed in which you can set a dif-
ferent target format.
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Now repeat the previous steps until all files that are
to be converted are entered in the list with the
according target folder and format.
Save the thus created list as CBL-file via the menu
option "file > save under...".

Edit ConvertPS Batch lists

The currently displayed ConvertPS Batch List can
be edited with the following operations:

Cut out elements:

by using the function "Cut out" on or more
elements can be cut out, thereby placed into the
clipboard and subsequently deleted from the list.

Copy elements:

by using the function "Copy" on or more elements
can be copied into the clipboard.

Insert elements:

"Insert", any elements from the clipboard can be
inserted anywhere into the list.

Delete elements:

by using "Delete", one or more elements can be
deleted from the list.
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Add elements:

by using the function "New Entry", a new element
can be added to the end of the list. (see also
point 1 and 2 of the section   "Create a ConvertPS
Batch list "!).

Change the target folder of an element:

by following the same guidelines as described
in "Create a ConvertPS Batch list", the target
folder alloted to the element in question can be
changed.

Note: All editing-operations are offered both in the
menu "Edit" as well as in the context menu. The
context menu appears by clicking the right mouse-
button.
Furthermore some of the functions can be activated
via the toolbar.
(see also chapter ConvertPS Batch "Toolbar")
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Selecting elements from the list

Before conducting any of the described operations
on particular elements in the list, these elements
have to be selected by mouseclick first.
If you want to select any elements listed directly
beneath one another in the list, simply keep the
shift key pressed while selecting both the first and
the last of these elements. All the elements listed
in between will be selected automatically too.
If you want to select various elements that are not
listed directly beneath one another in the list, keep
the CTRL key pressed while clicking those files
you wish to select. This enables you to collect the
files in question in one selection.
You can also undo the selection the same way:
keep the CTRL key pressed whilst clicking each
of the selected filenames you which to remove from
the selection.

Converting ConvertPS Batch lists

Proceed as follows to convert the currently displayed
ConvertPS Batch list partially or completely:

First of all select all elements in the currently
displayed ConvertPS Batch list you which to
convert by means of the batch mode.
For selecting numerous files use the Shift key or
STRG key method as described in "Selecting
elements from the list"
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Now activate the menu option "Start conversion".
You can choose this option either in the menu
"Edit", or in the context menu (click right mouse-
button)
Another possibility is to click the "Start" icon in
the toolbar

ConvertPS Batch will then work its way along the list
in sequences. Single paged documents will be saved
in the alloted target format and under the designated
target folder.
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ConvertPS Command Line

General
The ConvertPS Command Line program 'CPS.EXE'
enables the conversion of PostScript files in the
command prompt (DOS-Prompt, Shell) of Win-
dows\NT -\9X. To use this You open the Windows
command prompt, e.g. by clicking the 'START' button
and then point to 'Programs'. Click 'Command
Prompt' and change to the directory in which
ConvertPS has been installed. Now You can convert
PostScript files by entering the following text in the
command prompt:

C:\Programme\ConvPS45>
cps SOURCE /fFORMAT [/dZielpfad] [/o] [/i] [/?]

Command Line parameters
The parameters of ConvertPS Command Line
'CPS' mentioned above have got the following
meaning:

SOURCE:

For SOURCE the following inputs can be made:

Specifying a single file:

name.ps -  the file ‘name.ps‘
tite.eps -  the file ‘tite.eps‘
example.ai -  the file ‘example.ai‘
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Specifying files with wildcards:

abc*.ps - all files beginning with the
characters 'abc' and with file
extension '.ps'.

*.ps - all files with file extension '.ps'.

*.* - all files in the current directory.

????.ps - all files with four characters and
file extension '.ps'.

???yz.eps - all files that names consist of
five characters, end with yz and
that got the file extension '.eps'.

gh?????.* - all files that names consist of
seven characters and begin with
'gh'.

qrs???.ai - all files that names consist of
seven characters, begin with
'qrs' and that got the file exten-
sion '.ai'.

qrs???yz.ps - all files that names begin with
'qrs', end with 'yz', consist of
eight characters and that got he
file extension '.ps'.
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Specifying files with path referentce:

C:\PROGRAM FILES\CONVPS45\SAMPLES\test.ps

D:\Data\PostScript\*.eps

/fFORMAT:

The file(s) SOURCE shall be converted to the
referring format FORMAT. For FORMAT You can
choose between the following formats:

WMF -   Windows Metafile
WMFA -   Windows Metafile Aldus placeable
EMF -   Enhanced Metafile
SVG -   Scaleable Vector Graphics
PDF -   Portable Document Format
DXF -   Drawing Exchange Format
EPS -   Encapsulated PostScript
BMP -   Windows Bitmap
GIF -  Graphics Interchange Format
TIF -   Tagged Image Format
PCX -   PC Paintbrush Format

/dDest. Path:

With the target path You can choose the directory
where You want to save the converted file. The
target path has only to be indicated if You do not
want to store the file in the current directory.

/i:
With this option the dialog box with register cards
for the settings of the interpreter of ConvertPS
Batch will be opened. Here You can determine
the standard fonts and settings for PostScript.
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/o:
With this option the dialog box with the register
cards for determining output parameters will be
opened as described in ConvertPS Batch
'>Options>Output'. You can specify the output
parameters like rotation, colors, page format,
clipping, etc. in accordance to the selected
format. The conversion will be started after
confirmation of the settings.

/?:
With this option the help text will be called. You
get a short information about possibilities of
conversion in Command Line mode. With this
option no conversion will take place.

Examples:

General use
If You want to convert the file 'new.ps' in the GIF
format and to save the converted file in the
current directory so the input has to be:

cps new.ps /fGIF

The parameters 'SOURCE' and '/fFORMAT' are
the only parameters that always have to be
specified.
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Specifying the target path

If the converted file shall be saved in another
directory this can be made by referring to the
optional parameter '/dDest.path':

cps new.ps /fGIF /dC:\Examples\Test

After the conversion of 'new.ps' the file 'new.gif'
can be found in the directory 'C:\Examples\Test'.
If the indicated target directory does not exist the
conversion will be cancelled with a referring
message (see below).

Conversion with ‘wildcards‘

If You enter:

cps *.ps /fEMF

Convert PS converts all files with the file
extension '.PS' in the current directory in the EMF
format. In case this is a large number of files
You can direct the Command Line output in a
file, e.g. by entering the following input:

cps *.ps /fEMF >error.log

After the conversion has taken place You will find
all referring messages, particularly the error
messages in the file error.log This file can be
displayed e.g. with the text editor Notepad.
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Help of ConvertPS Command Line

If You need information about the available
parameters You can enter the following text in
the command line mode:

cps /?

Then the following short help text will appear on
the screen:

ConvertPS 4.5 - Command Line PostScript
Converter Copyright(c) 2000, Computer
Hake u. Said GmbH
Usage:
CPS SOURCE /fFORMAT [/dDest.path] [/o]
[/i] [/?]
SOURCE source files (wildcards are
possible)
/o,/O   display the output option dialog
/i,/I   display the interpreter option d.
/d,/D specify a path for destination files
/?      this help screen
FORMAT:
WMF  -> Windows Metafile
WMFA -> Aldus placeable Metafile
EMF  -> Enhanced Metafile (default)
SVG  -> Scaleable Vector Graphics
PDF  -> Portable Document Format
DXF  -> Drawing Exchange Format
EPS  -> Encapsulated PostScript
BMP  -> Windows Bitmap
GIF  -> Graphic Interchange Format
TIF  -> Tagged Image Format
PCX  -> PC Paintbrush
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Specifying the parameters for input and output

Change of interpreter settings

If You want to change the interpreter parameters
for conversion You can activate the dialog box
for the settings of interpreter options by adding '/
i'. For the conversion of the file 'new.ps' in the
SVG format with preselection of the interpreter
options the input has to be:

cps new.ps /fSVG /i

First the dialog box "Interpreter settings" appears.
In this dialog box You can change the interpreter
settings (see also chapter Options - Interpreter).
After closing the dialog box the conversion will
start with changed settings.

Change of output settings

Due to the interpreter settings You can change the
settings for the output format prior to conversion,
too. Therefore You add the option '/o':

cps new.ps /fGIF /o

Specifying the path for ConvertPS

If You want to start ConvertPS Command Line from
any directory without entering always the entire
program source path You should include CPS-
installation directory in the environment variable
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'PATH'. You can proceed this with following
methods:

1. Enter in the command prompt window:

set path=%path%;C:\PROGRAM\CONVPS45

And the specification of the source path of
ConvertPS is no longer needed. This setting is
valid for the current window session and will be
deleted after closing the command prompt
window.

2. If You work with Windows/NT You can use the
menu item  "Start>Settings>Control Panel> System"
and then include the directory of ConvertPS 4.5
in the environment variable 'PATH' under the
item "environment". This setting will be activated
by starting every new command prompt window.

3. If You work with Windows 95/98 You can
configure easy access to the ConvertPS
Command Line by adding the line:

set path=%path%;C:\PROGRAM\CONVPS45

Error messages

Unknown format

Example:

cps name.ps /fSVX

If You refer to a file format that is not known by
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ConvertPS (e.g. SVX) the following message
occurs on the screen:

ConvertPS 4.5 - Command Line PostScript
Converter Copyright© 2000, Computer Hake
u. Said GmbH
Unknown format: SVX
FORMAT:
  WMF  -> Windows Metafile
  WMFA -> Windows Metafile
  EMF  -> Enhanced Metafile (default)
  SVG  -> Scaleable Vector Graphics
  PDF  -> Portable Document Format
  DXF  -> Drawing Exchange Format
  EPS  -> Encapsulated PostScript
  BMP  -> Windows Bitmap
  GIF  -> Graphic Interchange Format
  TIF  -> Tagged Image Format
  PCX  -> PC Paintbrush

Not existing directory

Example:

cps new.ps /fGIF /dC:\Beispiel\Test

If the directory 'C:\Examples\Test' does not exist
and You enter the text above ConvertPS will
provide the following error message:

ConvertPS 4.5 - Command line PostScript
Converter Copyright© 2000, Computer Hake
u. Said GmbH

Could not find the directory:
C:\Examples\Test
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File not found

Example:

cps name.ps /fSVG

If ConvertPS cannot find the file 'name.ps' so
the error message

ConvertPS 4.5 - Command Line PostScript
Converter Copyright© 2000, Computer Hake
u. Said GmbH

File(s) not found : name.ps

occurs. Verify the specification of the file and start
the conversion again.

Too many parameters

If You enter too many parameters, e.g.

cps tiger.ps /fGIF /i /i

no conversion will take place and the error
message:

ConvertPS 4.5 - Command Line PostScript
Converter Copyright© 2000, Computer Hake
u. Said GmbH

Too many parameters!
Usage:  CPS SOURCE/fFORMAT [/dDest.path]

[/o] [/i] [/?]

occurs.
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Invalid parameters

If You enter a parameter which ConvertPS does
not use or forget the parameter input following
the character "/" the error message

ConvertPS 4.5 - Command Line PostScript
Converter Copyright© 2000, Computer Hake
u. Said GmbH

Unknown option:/
Aufruf: CPS SOURCE/fFORMAT [/dDest.path]

[/o] [/i] [/?]

occurs. Enter the slash with the correct
parameter and start conversion again.

Error messages of the interpreter

If an error occurs in PostScript code of the file to
be converted ConvertPS will provide the following
error message during conversion of the damaged
file 'bird.ps':

Converting bird.ps -> C:\PROGRAM\CONVPS$
\SAMPLES\bird.emf
Error: undefined near HALLO
File : C:\PROGRAM\CONVPS45\SAMPLES\bird.ps
Line : 8

An error exists in line 8 of the file 'bird.ps'. The
command "HALLO" cannot be translated from
the interpreter. The error messages issued here
are standard PostScript error messages. For
more information You should refer to corre-
sponding PostScript manuals PostScript-Hand-
büchern nachzulesen.
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ConvertPS Butler OLE: embedding

The procedure for embedding OLE-objects varies
from application to application. The actual method
though stays the same.
The procedures described here can therefore alter
depending on the application used. That means
names of the functions might vary, or the chain of
operations. With Microsoft e.g. you will find  "insert >
object" whereas with other applications you might look
for the function  "insert object" in the menu "edit"
(Adobe PageMaker).
On the whole all the single steps result in just the same
outcome.

Insert new file

This functions enables the assignment of a PostScript
file to an empty OLE object.
Via the operators "insert" and "object" you receive a
dialog window with 2 register cards on screen

Object

this dialog window offers two register cards for
selecting the desired OLE object.
These are called

- create new and
- create from file
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create new

On the first register card called "create new"
various object types can be selected from the list
offered. Select the object type "PostScript files"
by mouseclick.

create from file

If you already have a particular PostScript file
saved on your system you can choose this via the
registercard "Create from file".
Open this registercard by clicking the header of
the same name and it will offer you a searchbar
for finding and selecting the required Post-Script
file in your system structure.
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ConvertPS-Butler: Toolbar

First an empty object-frame is displayed in your
document and the toolbar of ConvertPS appears
within the application used.

If you now activate the option "insert new file" in the
menu "Edit" or click the button OLE INS, then the
dialog window "Open" will show up on screen. Here
you can select a particular file and confirm your choice
by clicking "Open".  This file will now be placed into
the empty object-frame in your document.You can
return to your initiating program by simply clicking onto
your document next to the object-frame. Now you can
continue with your work in your original program.



120

BUTLER

120

The ConvertPS OLE server is being loaded:

By selecting this function or by clicking the button
"OLE-INS" in the toolbar any other PostScript-files can
be assigned to the OLE frame.
In the example above, select the function "PostScript
File object > Open" instead of "PostScript File object
> Edit" and the interface of the ConvertPS OLE server
is activated.
After that the OLE-object is displayed once again in a
separate window with the title "PostScript File in nnn".
("nnn" stands for the name of the current document )
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The interface of the OLE server offers a complete
menu with ConvertPS own setting options concerning
the PostScript-file. The OLE object can be e.g.
exchanged by another here or changed in its settings.
Some of the setting options equal those options
offered in ConvertPS Classic.
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ConvertPS Butler: menu structure

Alltogether the OLE server of ConvertPS Butler has
the following  menu structure with the following options
and functions:

File

Insert new file 
Update nnn
Close

Edit

Copy metafile 

 View

Current page
First page 
Next page 
Previous page 
Page...
Abort conversion 
Zoom
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Options

General...
Interpreter
Output
EMF-conversion
WMF-conversion

Note:

The menu options "View" and "Options" are equi-
valent to the program ConvertPS Classic in both
their menu structure as well as their functions and
therefore will not be explained further here.

See chapter ConvertPSClassic: menu  "View"

See chapter ConvertPSClassic: "Options"
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File

Insert new file
see page 117

update nnn
With this function you can update the embedded
PostScript object in the initiating application (e.g.
WinWord). The head will read the name of the
document opened in  the original program instead
of  "nnn". You should use this function especially
then when you assign a new or different PostScript
file  to the OLE-object with "Insert new file".

Close
With this function the interface of the ConvertPS
Butler OLE server is closed. The OLE server is
not shut down by this but continues to work in the
background for the initiating application.

Edit

Copy metafile
With the function "Copy metafile" the current
metafile is copied into the clipboard. This image
can then be inserted into other user applications
and can be used for further alterations and editing.
At this point ConvertPS Butler also saves a copy
of the PostScript file in the clipboard. This object
can also be processed further in any other
application with OLE support.
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ConvertPSClassic: File associations

When ConvertPS is installed all .EPS, .AI and .PS
files are automatically associated with ConvertPS.
Because of this association you can open and display
PostScript files with help of ConvertPS simply by
double-clicking the name of a PostScript file in the
Explorer. Consequently the following operations are
performed automatically:

- ConvertPS is started.
- The PostScript file is openend by double-click.
- The first page of the opened file is displayed in

the WMF or EMF format.

Furthermore you can have the PostScript file printed
out with the help of ConvertPS, by selecting a
PostScript file in the Explorer and activate the
command "Print" in the context menu (press right
mousebutton).
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The following operations will thus be conducted:

- ConvertPS is startet.
- the selected PostScript file is opened by

doubleclick.
- all pages of the presently opened file are

converted and subsequently printed.
- ConvertPS is closed.
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ConvertPSClassic, -Batch, -Butler :
"Drag and Drop" capability

 "Drag and Drop" is a mechanism, with which objects
(e.g.files) may be conveyed to other applications
simply by "dragging" their symbol to the symbol or
active window of an application and "dropped" there.
(to drag: select the object in question and keep hold
of the left mouse button; to let go of (drop) the object:
let go of the mouse button).
ConvertPS understands this type of conveyance and
carries out the following procedures, depending on
the particular file endings::

*.PS-, *.EPS-,*.AI

When one or more PS, EPS or AI files are moved
over to ConvertPS Classic by "Drag and Drop",
ConvertPS Classic will carry out the conversion
of the file and display the first page.

*.CBL

You may also deliver batch files (.CBL) -so called
ConvertPS Batch lists- to ConvertPS Batch by
"Drag and Drop".

*.CPS

Both ConvertPS Classic and ConvertPS Batch
can receive ConvertPS configuration files (*.cps)
by "Drag and Drop".
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*.PS in any chosen application

PostScript files may be delivered furthermore to
any other applications (like e.g. WinWord,
Internet Explorer, etc.) by "Drag and Drop". As
these applications usually support OLE, the
ConvertPS Butler OLE server is thus activated
automatically.
ConvertPS Butler will convert the PostScript file
and display it within the application (e.g. in a
WinWord document).
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ConvertPSClassic, -Butler:
Advice and Tips

To help you avoid mistakes and achieve better
converting results, here some advice and useful
information on setting various parameters and
avoiding or eliminating occurring errors, illustrated
by a few examples.

The appropriate converting mode

The WMF- and the EMF format are the conversion
modes offered in the menu "Options". To take
outmost advantage of the graphical abilities of
PostScript, you should consider the following facts
when choosing the conversion mode:

the WMF format

The WMF format is supported by most Windows
applications. It is e.g. the only vector orientated
format which Office 95 and FrameMaker can
import without any problems.
Unfortunately the WMF format cannot realize all
the graphical features which PostScript may
include: clipping for example is one of them. Line
attributes such as "LineCaps", "Dash" and
"Linejoin" are not part of the WMF repertoire. The
rotation of Bitmaps is only possible in steps of
90 degrees.
Another disadvantage is the fact that WMF only
calculates absolute (16-Bit-) coordinates. When
rotating an object, it is not possible to employ a
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world transformation according to a trans-
formation matrix that is applicable at all times.
The coordinates of the intended rotation are
dependent on the absolute coordinates. So,
allthough PostScript works with the world
transformation matrix, all rotation coordinates
need to be calculated all over again to fit the 16
bit coordinates of WMF.

to sum up:
the WMF format might be supported by many
Windows applications, but is not able to make
full use of the graphical abilities PostScript has
to offer.

the  EMF-Format

Basically better results are achieved with the EMF
format. The EMF format allows unrestricted
bitmap rotation and supports world trans-
formation.
If you work in the EMF mode, the quality of the
conversion is strongly dependent on the type of
your system:
- Windows 95 does not understand the line

attributes "LineCaps", "Dash" and "Linejoin" -
neither in EMF nor WMF.

- In contrast to WMF, the EMF mode allows
limited clipping.

- Moreover EMF files converted with ConvertPS
on NT are not conform with Windows 95.

- In case you convert *.PS files to *.EMF files
on an NT system and subsequently want to
use them on a Windows 95 system, the



131

Advice and Tips

conversion needs to be performed in favour
of Windows 95. The option "Windows 95 EMF-
Format" offered on the registercard for the
output settings enables you to simulate
Windows 95 on the NT system.
EMF files created this way are then available
to Windows 95.

Consequently some of the EMF features are lost
to both Windows 95 and WindowsNT:
Windows95 in general does not support EMF
completely. EMF files created to match Win95
are reduced to such an extent that the specific
NT-capabilities for EMF cannot be applied any
longer. The EMF Format was originally not
created for Windows 95 directly, therefore it is
not fully supported by this operating system.
Although the EMF format is the newer, improved
format,it is only from a few applications supported
completely. Lastly only these applications can
benefit fully from the improvements and
advantages this format offers - Windows NT is
one of them.

to sum up:
That means the EMF offers better results in
Windows 95, but is not fully up to the graphical
capability of PostScript. If you want to make full
use of the graphical capability of PostScript, you
should work with the EMF mode on Win  NT.
Windows NT is the most suitable for converting
PostScript files in the EMF format because here
the EMF format is used as the internal spool
format.
It is recommended to always create bitmap
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formats in the EMF mode under Windows NT,
as all essential graphical possibilities of
PostScript can then be realized to the full.

Setting the page format

When activating "Options > Vector Formats > Out-
put", you can set the page formats for all vector
formats. The settings layed down here can have
widespreading effect on the output of the metafile.
Some of these effects will also be unexpected,
especially to the unexperienced user.
Therefore we would like to provide you with a
couple of guidelines for setting the page format:

The dialog box depicted opposite shows all settings
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relevant for setting the page format. The page
format presents that part of the world coordination
system that is visualised in the converting process.
Hence the page format should always be set in
accordance with the location and the size of the
metafile about  to be created.
Determine the page format so that the metafile is
placed completely on the set page.

For this purpose find out the coordinates for the
bounding box. These are given in the information
window of "File Info" in the menu "File".

example:
The bounding box coordinates of the metafile
presented above are (174; 303) and (377 ; 538).
The "Page format" was set to a DIN A5- format
with the origin (0 ; 0). Thus the page is bounded by
the coordinates (0 ; 0) and (421 ; 595) (size of a
DIN A5 page in points).
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If the origin of the page is moved down 200 points
(to the coordinates (0; 200)) and the other settings
remain as before, the result is this:

Obviously the image was cut off at the bottom, as
it could not be grasped completely by the page set
in this way. In the extreme, it could even happen
that the image is situated completely out of the
range of the set page. Therefore it is vital to find
the most appropriate settings for both the page
format and the origin, considering the size of the
image, so that the image is placed where you can
see it and ideally, where you want it.
As the bounding box coordinates are voluntary
entries in the PostScript file, it is also possible that
they are either incorrect or non existent. Hence
you might not detect any information concerning
the coordinates in the info window, or the
information given is not correct. In case the image
is cut off by the page allthough the coordinates of
the page were set equivalent to those of the
bounding box, then they are unfortunately wrong
and useless.
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Now it is up to you to experiment, until the image
is placed on the page completely. Also try to position
the image sensibly on the page.
Determine the origin, so that the metafile is
positioned on the set page as required
The following image depicts a page with a square
page format-setting and an origin of (0;0).

With this setting, the framed "A" is located at the
bottom left. If you want to have the "A" elsewhere
on the same page, you have to leave the page
format as it is, but change the origin.
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This screenshot shows the same image with
altered origin-coordinats. In this example the origin
was changed to (90;90).  Now the origin is located
top right. As you can see, it is not always easy to
set the page format in such a way that the metafile
fits perfectly onto the page and is positioned as
desired. Especially when there are no coordinates
given for the bounding box, the matter becomes
slightly tricky and requires a little patience and sen-
sitive experimenting.

note:
the setting for the page format only has effect on
the presentation of the metafile, when either "Set
bounding box to page format" or "Activate clipping"
(dialog box "Output") is activated.
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When you deactivate the function "set page format
as Bounding-Box", the bounding-Box of the
PostScript objects is used as the outpput format
for the metafile unless you have also activated the
option "Clipping". If "Clipping" is switched on the
set page format is used as the basic clip path. This
will then effect the display of the metafile in question
if it is not overwritten by any other clippath.
If the PostScript file includes a setpagedevice, the
activated function "Set bounding box to page
format" is overruled.
Finally it remains to be said that there is another
rather simple possibility to set the page format, by
using the "Cut" function in the menu "Edit ".
In case you have activated the function "cut out",
you can determins the pageformat by creating a
selection box over the displayed metafile. The page
format set with this method can not be overwritten,
not even with a PostScript operator such as
"setpagedevice".
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PostScript print

When a PostScript file is to be converted, but shall
also remain printable on a PostScript printer, the
PostScript code needs to be embedded.
The file may be imported by applications unfit for
PostScript, yet the PostScript code remains
available for PostScript printers. If the embedded
PostScript code includes commands that are
prohibited in EPS files (e.g.`showpage’), this could
lead to faulty prints.
Usually the importfilter encapsulates the embedded
PostScript code to such an extent that most of
these commands show no further effect and the
file consistency remains in its original (stacks,
dictionaries, graphic status, etc.).
Unfortunately this cannot always be guaranteed
and sometimes the print does not turn out as
desired. In such a case you should simply refrain
from embedding the PostScript code and be
content with printing the metafile.
When the imported image includes a bitmap that
was created with the PostScript operator
`colorimage’, the according document can only be
printed on PostScript color printers. If such a color
printer is not available to you, leave out the
embedded PostScript code. The PostScript print
driver will turn the color image into a grey scale
image.
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PostScript file is not displayed

Various different reasons can cause a failure in
displaying a PostScript file.
One possibility is that a metafile could not be
created because the number of clippaths has
exceeded the allowed maximum.
Instead of the metafile you will receive the message
"A PostScript error has occured". Which PostScript
error, (in this case "Clippath overflow") is mentioned
in the standard outputwindow, i.e. info window.
- Now you should increase the allowed value for

the maximum path length in the register card
"PostScript" which you find under "Interpreter..."
in the menu "Options".

- Additionally you should decrease the number of
straight lines used for the curve approximation.
This is to be found in "Options > Output > Vector
Formats".

Both of these measures simplify the calculation of
the clippaths and can therefore prevent a "Clippath
overflow".
But the longer the maximum path length and the
smaller the number of straight lines used for the
curve approximation, the worse the quality of the
created metafile becomes.
When an empty display window appears, you can
assume that the metafile was at least created.
In this case the problem often lies with the setting
of the page format in the menu "Options > Output
> Vector Formats...".
- It may be that the PS-object is located completely

outside the range of the presently set page.
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- It could also be that the PostScript file was
converted with the "clipping" function activated
and thus that part of the image was clipped by
the clippath, but would have otherwise appeared
on the displayed page.

The created metafile cannot be displayed either, if
the option "Set bounding box to page format" is
activated, yet the page format was set in such a
way that the image is not positioned on it.
Perhaps the size of the page was set too small, so
that that part of the file, which is displayed in the
window, is blank itself.
Whatever the case may be, check the setting for
the page format and try various combinations.

Images look overlapped

When PostScript files are converted without
clipping, although clippaths are included, the
created images look strangely overlapped, e.g. the
following image includes clippaths .
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The first image was created with deactivated, the
second image with activated clipping.

As you can see, the grey striped area is displayed
in total, when the "clipping" is not active during the
conversion. When the "clipping" is activated, the
area is reduced and limited by the clippath which
is included in the native PostScript.
On the whole it can be said:
if you suspect the result of the conversion to consist
of various overlapping areas, check the setting of
the "clipping" function.
Try repeating the conversion with the alternative
setting for the "clipping" and compare the result.
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Font presentation is too angular

When converting text in ConvertPS, it might be
that the fonts presented look harsh and angular.
The two examples shown below were both
converted from the same PostScript file.

When you compare the two scripts, you will notice
that the top example looks a lot more angular, than
the one below:

The reason for this lies in the different settings in
the command "Transform text into paths" in the
menu "Options > Output > Vector Formats". The
writing at the top was converted with "Transform
text into paths". The bottom example was
converted without this command, i.e. the text was
not transformed into paths. Allthough this option
has this rather unsightly effect, especially on small
character sizes, it is essential for certain other
purposes like e.g. when using a character outline
that includes an alias font as clippath!
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PS error warning, aborting conversion

ConvertPS reports an error warning on screen, to
state a fault in the converting process and ends
the conversion. To receive a more precise definition
of the error, take a look at the report of the standard
output in the info window.
In the example below, the error "undefined"
occured.

The error warnings issued by ConvertPS comply
with the standard for PostScript interpreters.
To correct these errors, profound knowledge of the
page description language PostScript is
neccessary. An exact description of these warnings
would be too complex a matter to explain in this
manual. Therefore we can only refer you to
secondary literature concerning PostScript, in
which all PostScript operators and their functionality
are described precisely.
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One the one hand, most of the PostScript errors
are caused by faulty PostScript or Encapsulated
PostScript files (e.g. "syntax error" or "undefined
operator").
On the other hand, errors might occur due to or
the PostScript limits are overstretched or broken
(e.g. "stack overflow" or "VM Error"). These errors
can be resolved by changing certain settings within

Various types of errors

possible causes and how to eliminate them:

 - VM error
- pathoverflow/limitcheck
- stackoverflow

VMerror:

this error occurs in connection with the memory
management. This might be caused by ConvertPS
not providing enough memory to conclude the
conversion. In this case an increase of the "Maxi-
mum local memory" in the PostScript menu
"Options > Interpreter" should resolve the problem.

path overflow / limitcheck:

The number of path elements in the PostScript path
has exceeded the preset limits.
To preserve memory recources, the default setting
for the maximium path length in ConvertPS  is
2048. You can increase this value in the
“PostScript“ register card ("Options > Interpreter")
up to 20480. Often an increase of one- to two
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thousand is sufficient to eliminate this error.
Another reason for a "path overflow" might be found
in the settings for "straight lines in curve
approximation" in the dialogbox "Vector format
settings" ("Output" in the menu "Options"). The
default setting here is "8", which has proved a sen-
sible value, but may be increased up to128. The
more lines used to depict a curve, the smoother
the curve gets, yet the amount of elements (each
line = 1 element) is increased accordingly and with
it, the memory used. Hence a high number of lines
in the curve approximation might also lead to the
error "path overflow".

stack overflow:

The number of stack elements in one of the three
stacks has exceeded the set value. In order to
preserve memory resources, the default settings
for the various stacks are determined at a sensi-
ble maximum for the specific purposes. You may
increase the values in the register card "PostScript"
("Options > Interpreter") to allow ConvertPS to use
more memory and thus avoid this error.
Warnings concerning "missing fonts" or
"automatically substituted fonts" can be avoided
or resolved by varying the settings in the register
card "Fonts" ("Options > Interpreter").
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AcrobatReader
AcrobatReader is a free available software application
to visualize PDF-Files from Adobe Inc.

ADSC-Comments
Adobe Document Structuring Convention - PostScript
documents can contain so-called ADSC-comments
which inform the interpreter e.g. how many pages the
referring PostScript file consists of.

AI-Format
Adobe Illustrator file format

Alias-Name
With an "Alias-Name" in ConvertPS another name for
a PostScript-Font is defined. There can be multiple
Alias-Names referring to a single PostScript-Font.
During conversion ConvertPS uses the Alias-Name
in order to emulate a not-existing PostScript-Font by
an existing one.

Alias-Font
An Alias-Font is an additional writing type.

Aldus Placeable Metafile (APM)
If you save graphics as Windows Metafile (WMF) only
the referring program knows the essential information
to process in work on the file. Aldus, the producer of
PageMaker has defined an expanded format: the
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Aldus Placeable Metafile (APM). Here is additional
scaling information included to ensure a successful
reproducibility of vector graphics to other applications.
This format is supported by some other applications
beside PageMaker, such as e.g. Microsoft Word.

Batch
Batch-processing - automatic program control process
of commands.

BMP
BMP stands for Bitmap. It is a standard for Windows
picture formats (*.bmp) The picture format supports
grey-scaled pictures and 24-bit RGB color pictures.

Bounding-Box
The "Bounding Box" defines the smallest rectangle to
describe a shown object. There are the coordinates
of the left upper and the right lower corner points given
in points (1 point=1/72 zoll, about 0.04 mm). This is
one of the information which is stored in additional
comment areas in (E)PS-files.

Cache
Serves for the storage of data in a buffer (background
memory) and makes this data available very quickly.

CBL
ConvertPS batchlist - files, which are converted in
batch-mode are added the suffix CBL.
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Clipboard
Section of the working memory, which is used by
applications and the operation system, to store data
in between. It serves for copying and moving of data,
programs, pictures, ... between different programs.

Clipping
With clipping we define the bordering of a picture area,
of which graphics are given out.

CMYK
This abbreviation stands for "cyan, magenta, yellow,
key color (blacky)" which is known as a subtractive
color scheme and is used for color printing.

Compression
This means data compression. It is a method, that is
made for the reduction of data size. There are diffe-
rent methods, one simple method is for example to
reduce100 equal letters (YYY...Y) and use the expres-
sion 100Y.

Converting
Transforming of data formats.

CPS
ConvertPS Settingfile - contains all ConvertPS para-
meters in file format.

Dictionary stack
In a dictionary Stack the necessary program libraries
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are found, these are at least two, the system library
and the user library. See also "Stack".

Dithering
Serves to emulate not-supported colors with a reduced
color palette by using closely packed points of diffe-
rent colors out of the palette.

dpi
dpi means dots per inch. It is an old English metric
measurement. The unit describes the number of points
in a defined area and through that the quality of the
picture. It applies for printing, scanning of graphics.
On the screen there is a standard resolution of 72 dpi.

drag and drop
With the function drag and drop single parts of a
document or the whole document itself can be marked
and with the hold left mouse button moved within
another window or taken into another application and
dropped down there.

DSC-Convention
Data Structuring Conventions - contain information
about the document like the number of pages, the
colors, fonts, etc.

EMF
Encapsulated Metafile is a data format for graphics
processing and belongs to vector formats.
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EPS
Encapsulated PostScript - in contrast to simple PS-
files the EPS-format contains additional information
about the used fonts and the scaling of the described
vector graphics, like e.g. the "bounding box". This
information is located in the EPS-file in that way, that
it refers to specific structure conventions. This allows
text and graphics programs to enclose the EPS-file in
a document and to print them with a PostScript Printer.
Optionally a  simplefied preview (bitmap) of the
graphics can be included. With this preview the
applications can produce a picture of the graphics on
the screen.

Execution stack
PS-interpreter - in the execution Stack the workable
procedures inside of a PostScript-document are
stored. See also "Stack".

Font
Different fonts are used to give a specific layout to
characters. These fonts are a collection of letters,
numbers and symbols and their appearance, like e.g.
bold, italic, Times, Courier and a combination of these,
like e.g. TimesNewRoman_BoldItalic. The fonts are
defined by pixels or vectors.

Garbage collection
The garbage collection contains files that "steal" a lot
of storage capacity and are no longer needed.
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GIF
The "Graphics Interchange Format" has proved to be
a system-wide exchange-format for pixel represen-
tation and was especially developed for this purpose.
It is frequently used in the internet, because this format
provides a good picture quality in respect to small file
size.

Import filter
Program modules to transform unknown file formats
in order to be usable and for example to include them
in an existing document.

Interlaced
Method of saving pictures which allows pictures sent
on the internet to impress sharper and sharper during
construction of them.

Interpreter
Translator - program which converts data from one
programming language into another.

LZW-Compression
Method of compression with the patented Lempel Ziv
Welsh packing algorithm.

Marquise
As a marquee we call a marked screen part. Marquees
are often rectangular, but they also can be of circular
or elliptic shape.
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MDI
Multidocument Interface - several files can be opened
and edited at the same time.

Metafile
see also WMF, EMF.

OLE
Object Linking and Embedding,- data will be linked
from a source document with data in a target document
or the data will be embedded/integrated. If You mark
the object in the target document the original source
document will be opened again and can be edited.

Operanden Stack
PS-interpreter - in the operand stack you will find the
information for processing PostScript-files, like e.g.
numbers, letters and characters. See also "Stack".

Pack Bits
Method of compression which uses the bit level -
analogous to RLE.

to parse
to parse means to split in parts (tokens) and to divide
into numbers, operators, Strings ...

Path overflow
Path overflow describes an error message. If a path
overflow occurs the maximum number of path
elements is exceeded.
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PCX
This is a pixel format and it is comparable to the BMP-
format of Windows. PCX is mainly used in not-
windows-based applications, for example MS-DOS
applications.

PDF
Portable Document Format - Adobe defined this
document format. This format displays system-wide
all kinds of documents.

Pixel
A pixel is a single point of a picture and is the smallest
unit in graphics processing.

Polygon
Geometric form which is composed by more than two
line segments. It constructs triangles, rectangles, n-
angles.

PostScript (PS) 
PostScript is a language to describe pages, with which
text, geometrical figures and raster graphics can be
described tool-independently on a higher level. This
objects can be rotated enlarged, made smaller and
filled with patterns without loosing quality. Applied to
the PostScript fonts unique effects are made, which
have lead to a quality symbol of PostScript. Today
PostScript has made itself to a standard for page-
describing languages and is used on different
computer systems. PostScript is very often the only
opportunity to exchange graphics or document's
between different computer systems.
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Raster graphics
With raster graphics all picture points are stored
separately. The quality of the picture is defined by the
number of picture points. Raster graphics need a lot
of memory for storing, but use less CPU time.

RGB
RGB stands for red, green, blue. All colors to be
displayed on the screen are composed by these three
basic colors. It is also called an additive color system.

RLE-Compression
Run-Lengs-Compression, one of the easiest compres-
sion methods, which works with characters or
dimension units. It serves very well for black/white
pictures.

Scaling factor
The scaling factor reflects the relation between the
referring axes on the screen and the size of the origin.

Source format
Source format is the format in which a file is stored
electronically.

Stack
A stack is a heap memory. It can work with two diffe-
rent methods. With "last in first out" (lifo) the last stored
element will be taken first, then the previous one etc.
With "first in first out" (fifo) the first stored element will
be taken first, then the second one etc.
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Target directory
During  the saving process the directory in the file
tree is referred into which a file shall be saved. This
directory is called target directory.

Target format
Target format is the format in which the file shall be
saved.

TIFF/TIF
The Tagged Image Format is the most-known and
varied graphics format for pixel representation. It has
established into a standard for storing scanned and
digitalized pictures. It does not support picture levels
and cannot be taken for animation.

True-Type font
The True-Type Font is defined by Microsoft and Aplle
and is the basic font in the referring applications. It is
defined through vectors and can be scaled without
loosing quality.

Vector graphics
In contrast to raster graphics with vector graphics not
every single picture point is stored, only some
predefined points are stored, which are linked later.
They need less memory in comparison to raster
graphics, but they need more CPU time.
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Wildcards
Wildcards are characters which are used on the
command line to define filename patterns. In these
patterns the question-mark (?) stands for one arbitrary
character and the asterisk (*) stands for any arbitrary
- even empty - character sequence. Programs which
are accepting wildcards work on all files whose names
fit into the given pattern.For example, the command

copy a*.c c:\temp

copies all the files in the current directory whose
names start with an 'a' and end with '.c' to the directory
'c:\temp'. This holds also for a file named 'a.c', if it
exists.

WMF
Windows Metafile - Windows uses a specific data
format to exchange graphics between applications:
This format contains representations of internal
graphics functions (GDI) of Windows and serves an
easy way to store graphics from an application or to
make them readable to others. For general processing
of these graphics the Aldus Placeable Metafile format
has pushed through. This format is accepting either
pixel and vector-oriented data transfer.
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Command Line
Error messages  113
General  106
Help  111
Input and output  112
Interpreter settings  112
Output settings  112
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Single file  106
Wildcards  107
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Insert new file  117
Insert PS comments  63
Install PostScript font  47
Install TrueType font  48
Install TrueType fonts  48
Installation

by CD-Rom  14
by disc  15

Interlaced  151
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Interpreter  151
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L
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TIFF/TIF  155
to parse  152
Transform

Bitmap into paths  66
Lines into paths  63
Text into paths  60

TrueType font  48, 155
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Vector graphics  155
View  35
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